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Preface
Notice
The company reserves the right to revise this publication or to change its contents without notice. Information
contained herein is for reference only and does not constitute a commitment on the part of the manufacturer or
any subsequent vendor. They assume no responsibility or liability for any errors or inaccuracies that may appear
in this publication nor are they in anyway responsible for any loss or damage resulting from the use (or misuse)
of this publication.
This publication and any accompanying software may not, in whole or in part, be reproduced, translated, trans-
mitted or reduced to any machine readable form without prior consent from the vendor, manufacturer or creators
of this publication, except for copies kept by the user for backup purposes.
Brand and product names mentioned in this publication may or may not be copyrights and/or registered trade-
marks of their respective companies. They are mentioned for identification purposes only and are not intended
as an endorsement of that product or its manufacturer.
©July 2015

Trademarks
Intel, Pentium and Intel Core are trademarks/registered trademarks of Intel Corporation.
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Preface
R&TTE Directive
This device is in compliance with the essential requirements and other relevant provisions of the R&TTE Direc-
tive 1999/5/EC.

This device will be sold in the following EEA countries: Austria, Italy, Belgium, Liechtenstein, Denmark, Lux-
embourg, Finland, Netherlands, France, Norway, Germany, Portugal, Greece, Spain, Iceland, Sweden, Ireland,
United Kingdom, Cyprus, Czech Republic, Estonia, Hungary, Latvia, Lithuania, Malta, Slovakia, Poland, Slov-
enia.

ErP Off Mode Power Consumption Statement:
The figures below note the power consumption of this computer in compliance with European Commission (EC)
regulations on power consumption in off mode:

• Off Mode < 0.5W
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Preface
CE Marking
This device has been tested to and conforms to the regulatory requirements of the European Union and has at-
tained CE Marking. The CE Mark is a conformity marking consisting of the letters “CE”. The CE Mark applies
to products regulated by certain European health, safety and environmental protection legislation. The CE Mark
is obligatory for products it applies to: the manufacturer affixes the marking in order to be allowed to sell his
product in the European market.

This product conforms to the essential requirements of the R&TTE directive 1999/5/EC in order to attain CE
Marking. A notified body has determined that this device has properly demonstrated that the requirements of the
directive have been met and has issued a favorable certificate of expert opinion. As such the device will bear the
notified body number 0560 after the CE mark.

The CE Marking is not a quality mark. Foremost, it refers to the safety rather than to the quality of a product.
Secondly, CE Marking is mandatory for the product it applies to, whereas most quality markings are voluntary.
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Preface
FCC Statement
(Federal Communications Commission)
You are cautioned that changes or modifications not expressly approved by the party responsible for compliance
could void the user's authority to operate the equipment.

This equipment has been tested and found to comply with the limits for a Class B digital device, pursuant to Part
15 of the FCC Rules. These limits are designed to provide reasonable protection against harmful interference in
a residential installation. This equipment generates, uses and can radiate radio frequency energy and, if not in-
stalled and used in accordance with the instructions, may cause harmful interference to radio communications.
However, there is no guarantee that interference will not occur in a particular installation. If this equipment does
cause harmful interference to radio or television reception, which can be determined by turning the equipment
off and on, the user is encouraged to try to correct the interference by one or more of the following measures:

• Re orient or relocate the receiving antenna.
• Increase the separation between the equipment and receiver.
• Connect the equipment into an outlet on a circuit different from that to which the receiver is connected.
• Consult the service representative or an experienced radio/TV technician for help.

Operation is subject to the following two conditions:

1. This device may not cause interference.

And

2. This device must accept any interference, including interference that may cause undesired operation of the 
device.
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Preface
FCC RF Radiation Exposure Statement:

1. This Transmitter must not be co-located or operating in conjunction with any other antenna or transmitter.

2. This equipment complies with FCC RF radiation exposure limits set forth for an uncontrolled environment. This 
equipment should be installed and operated with a minimum distance of 20 centimeters between the radiator 
and your body.


Warning

Use only shielded cables to connect I/O devices to this equipment. You are cautioned that changes or modifications not ex-
pressly approved by the manufacturer for compliance with the above standards could void your authority to operate the
equipment.
V



Preface
IMPORTANT SAFETY INSTRUCTIONS
Follow basic safety precautions, including those listed below, to reduce the risk of fire, electric shock, and injury
to persons when using any electrical equipment:

1. Do not use this product near water, for example near a bath tub, wash bowl, kitchen sink or laundry tub, in a wet 
basement or near a swimming pool.

2. Avoid using this equipment with a telephone line (other than a cordless type) during an electrical storm. There 
may be a remote risk of electrical shock from lightning.

3. Do not use the telephone to report a gas leak in the vicinity of the leak.
4. Use only the power cord and batteries indicated in this manual. Do not dispose of batteries in a fire. They may 

explode. Check with local codes for possible special disposal instructions.
5. This product is intended to be supplied by a Listed Power Unit as follows:

• AC Input of 100 - 240V, 50 - 60Hz, DC Output of 19V, 4.74A (90 Watts) minimum AC/DC Adapter.
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Preface
Instructions for Care and Operation
The notebook computer is quite rugged, but it can be damaged. To prevent this, follow these suggestions:

1. Don’t drop it, or expose it to shock. If the computer falls, the case and the components could be damaged.

2. Keep it dry, and don’t overheat it. Keep the computer and power supply away from any kind of heating ele-
ment. This is an electrical appliance. If water or any other liquid gets into it, the computer could be badly dam-
aged.

Do not expose the computer 
to any shock or vibration.

Do not place it on an unstable 
surface.

Do not place anything heavy 
on the computer.

Do not expose it to excessive 
heat or direct sunlight.

Do not leave it in a place 
where foreign matter or mois-
ture may affect the system.

Don’t use or store the com-
puter in a humid environment.

Do not place the computer on 
any surface that will block the 
Vents/Fan Intakes.
VII



Preface
3. Avoid interference. Keep the computer away from high capacity transformers, electric motors, and other 
strong magnetic fields. These can hinder proper performance and damage your data.

4. Follow the proper working procedures for the computer. Shut the computer down properly and don’t forget 
to save your work. Remember to periodically save your data as data may be lost if the battery is depleted.

5. Take care when using peripheral devices.

Do not turn off the power 
until you properly shut down 
all programs.

Do not turn off any peripheral 
devices when the computer is 
on.

Do not disassemble the com-
puter by yourself.

Perform routine maintenance 
on your computer.

Use only approved brands of 
peripherals.

Unplug the power cord before 
attaching peripheral devices.
VIII



Preface
Power Safety
The computer has specific power requirements:

• Only use a power adapter approved for use with this computer.
• Your AC/DC adapter may be designed for international travel but it still requires a 

steady, uninterrupted power supply. If you are unsure of your local power specifications, 
consult your service representative or local power company.

• The power adapter may have either a 2-prong or a 3-prong grounded plug. The third 
prong is an important safety feature; do not defeat its purpose. If you do not have access 
to a compatible outlet, have a qualified electrician install one.

• When you want to unplug the power cord, be sure to disconnect it by the plug head, not 
by its wire.

• Make sure the socket and any extension cord(s) you use can support the total current 
load of all the connected devices.

• Before cleaning the computer, make sure it is disconnected from any external power 
supplies (i.e. AC/DC adapter or car adapter).

Do not plug in the power 
cord if you are wet.

Do not use the power cord if 
it is broken.

Do not place heavy objects 
on the power cord.


Power Safety 

Warning

Before you undertake
any upgrade proce-
dures, make sure that
you have turned off the
power, and discon-
nected all peripherals
and cables (including
telephone lines and
power cord). 

You must also remove
your battery in order to
prevent accidentally
turning the machine
on. Before removing
the battery discon-
nect the AC/DC
adapter from the
computer.
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Preface
Polymer Battery Precautions
Note the following information which is specific to polymer batteries only, and where applicable, this overrides
the general battery precaution information overleaf.

• Polymer batteries may experience a slight expansion or swelling, however this is part of the battery’s safety mecha-
nism and is not a cause for concern.

• Use proper handling procedures when using polymer batteries. Do not use polymer batteries in high ambient tempera-
ture environments, and do not store unused batteries for extended periods.

See also the general battery precautionary information overleaf for further information.
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Preface
Battery Precautions
• Only use batteries designed for this computer. The wrong battery type may explode, leak or damage the computer.
• Do not remove any batteries from the computer while it is powered on.
• Do not continue to use a battery that has been dropped, or that appears damaged (e.g. bent or twisted) in any way. Even 

if the computer continues to work with a damaged battery in place, it may cause circuit damage, which may possibly 
result in fire.

• If you do not use the battery for an extended period, then remove the battery from the computer for storage.
• Recharge the batteries using the notebook’s system. Incorrect recharging may make the battery explode.
• Do not try to repair a battery pack. Refer any battery pack repair or replacement to your service representative or qual-

ified service personnel.
• Keep children away from, and promptly dispose of a damaged battery. Always dispose of batteries carefully. Batteries 

may explode or leak if exposed to fire, or improperly handled or discarded.
• Keep the battery away from metal appliances.
• Affix tape to the battery contacts before disposing of the battery.
• Do not touch the battery contacts with your hands or metal objects.


Battery Disposal & Caution

The product that you have purchased contains a rechargeable battery. The battery is recyclable. At the end of its useful life,
under various state and local laws, it may be illegal to dispose of this battery into the municipal waste stream. Check with
your local solid waste officials for details in your area for recycling options or proper disposal.

Danger of explosion if battery is incorrectly replaced. Replace only with the same or equivalent type recommended by the
manufacturer. Discard used battery according to the manufacturer’s instructions.
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Cleaning
Do not apply cleaner directly to the computer; use a soft clean cloth. 
Do not use volatile (petroleum distillates) or abrasive cleaners on any part of the computer.

Servicing
Do not attempt to service the computer yourself. Doing so may violate your warranty and expose you and the
computer to electric shock. Refer all servicing to authorized service personnel. Unplug the computer from the
power supply. Then refer servicing to qualified service personnel under any of the following conditions:

• When the power cord or AC/DC adapter is damaged or frayed.
• If the computer has been exposed to rain or other liquids.
• If the computer does not work normally when you follow the operating instructions.
• If the computer has been dropped or damaged (do not touch the poisonous liquid if the LCD panel breaks).
• If there is an unusual odor, heat or smoke coming from your computer.


Removal Warning

When removing any cover(s) and screw(s) for the purposes of device upgrade, remember to replace the cover(s) and
screw(s) before restoring power to the system.

Also note the following when the cover is removed:

• Hazardous moving parts.
• Keep away from moving fan blades.
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Travel Considerations

Packing
As you get ready for your trip, run through this list to make sure the system is ready to go:

1. Check that the battery pack and any spares are fully charged.
2. Power off the computer and peripherals.
3. Close the display panel and make sure it’s latched.
4. Disconnect the AC/DC adapter and cables. Stow them in the carrying bag. 
5. The AC/DC adapter uses voltages from 100 to 240 volts so you won’t need a second voltage adapter. However, 

check with your travel agent to see if you need any socket adapters.
6. Put the notebook in its carrying bag and secure it with the bag’s straps.
7. If you’re taking any peripherals (e.g. a printer, mouse or digital camera), pack them and those devices’ adapters 

and/or cables.
8. Anticipate customs - Some jurisdictions may have import restrictions or require proof of ownership for both 

hardware and software. Make sure your documents are prepared.


Power Off Before Traveling

Make sure that your notebook is completely powered off before putting it into a travel bag (or any such container). Putting a
notebook which is powered on in a travel bag may cause the vent(s)/fan intake(s)/outlet(s) to be blocked. To prevent your
computer from overheating make sure nothing blocks the vent(s)/fan intake(s)/outlet(s) while the computer is in use.
XIII
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On the Road
In addition to the general safety and maintenance suggestions in this preface, and Chapter 8: Troubleshooting,
keep these points in mind:

Hand-carry the notebook - For security, don’t let it out of your sight. In some areas, computer theft is very
common. Don’t check it with normal luggage. Baggage handlers may not be sufficiently careful. Avoid knock-
ing the computer against hard objects.

Beware of Electromagnetic fields - Devices such as metal detectors & X-ray machines can damage the com-
puter, hard disk, floppy disks, and other media. They may also destroy any stored data - Pass your computer and
disks around the devices. Ask security officials to hand-inspect them (you may be asked to turn it on). Note:
Some airports also scan luggage with these devices.

Fly safely - Most airlines have regulations about the use of computers and other electronic devices in flight.
These restrictions are for your safety, follow them. If you stow the notebook in an overhead compartment, make
sure it’s secure. Contents may shift and/or fall out when the compartment is opened.

Get power where you can - If an electrical outlet is available, use the AC/DC adapter and keep your battery(ies)
charged.

Keep it dry - If you move quickly from a cold to a warm location, water vapor can condense inside the computer.
Wait a few minutes before turning it on so that any moisture can evaporate.
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Developing Good Work Habits
Developing good work habits is important if you need to work in front of the computer for long periods of time.
Improper work habits can result in discomfort or serious injury from repetitive strain to your hands, wrists or
other joints. The following are some tips to reduce the strain:

• Adjust the height of the chair and/or desk so that the keyboard is at or slightly below the level 
of your elbow. Keep your forearms, wrists, and hands in a relaxed position.

• Your knees should be slightly higher than your hips. Place your feet flat on the floor or on a 
footrest if necessary.

• Use a chair with a back and adjust it to support your lower back comfortably.
• Sit straight so that your knees, hips and elbows form approximately 90-degree angles when 

you are working.
• Take periodic breaks if you are using the computer for long periods of time.

Remember to:
• Alter your posture frequently.
• Stretch and exercise your body several times a day.
• Take periodic breaks when you work at the computer for long periods of time. Frequent and 

short breaks are better than fewer and longer breaks.
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Lighting
Proper lighting and comfortable display viewing angle can reduce eye strain and muscle fatigue in your neck and
shoulders.

• Position the display to avoid glare or reflections from overhead lighting or outside sources of light.
• Keep the display screen clean and set the brightness and contrast to levels that allow you to see the screen clearly.
• Position the display directly in front of you at a comfortable viewing distance.
• Adjust the display-viewing angle to find the best position.

LCD Screen Care
To prevent image persistence on LCD monitors (caused by the continuous display of graphics on the screen for
an extended period of time) take the following precautions:

• Set the Windows Power Plans to turn the screen off after a few minutes of screen idle time.
• Use a rotating, moving or blank screen saver (this prevents an image from being displayed too long).
• Rotate desktop background images every few days.
• Turn the monitor off when the system is not in use.

LCD Electro-Plated Logos
Note that in computers featuring a raised LCD electro-plated logo, the logo is covered by a protective adhesive.
Due to general wear and tear, this adhesive may deteriorate over time and the exposed logo may develop sharp
edges. Be careful when handling the computer in this case, and avoid touching the raised LCD electro-plated
logo. Avoid placing any other items in the carrying bag which may rub against the top of the computer during
transport. If any such wear and tear develops contact your distributor/supplier.
XVI
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Quick Start Guide 1
Chapter 1: Quick Start Guide

Overview
This Quick Start Guide is a brief introduction to the basic features of your computer, to navigating around the
computer and to getting your system started. The remainder of the manual covers the following:

• Chapter 2 A guide to using some of the main features of the computer e.g. the storage devices (hard disk, 
optical device, card reader), Touchpad/Mouse and Audio.

• Chapter 3 The computer’s power saving options.
• Chapter 4 The installation of the drivers and utilities essential to the operation or improvement of some of the 

computer’s subsystems.
• Chapter 5 An outline of the computer’s built-in software or BIOS (Basic Input Output System).
• Chapter 6 A quick guide to the computer’s PC Camera, Wireless LAN, Bluetooth & WLAN Combo, Secu-

rity and Intel Technology modules (some of which may be optional depending on your purchase 
configuration).

• Chapter 7 A troubleshooting guide.
• Appendix A Definitions of the interface, ports/jacks which allow your computer to communicate with external 

devices.
• Appendix B Information on Control Center.
• Appendix C Information on the video driver controls.
• Appendix D The computer’s specification.
• Appendix E Information on the Windows 10 operating system.
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Quick Start Guide1

Advanced Users
If you are an advanced user you may skip over most of this Quick Start Guide. However you may find it useful
to refer to “What to Install” on page 4 - 1, “BIOS Utilities” on page 5 - 1 and “Upgrading The Computer” on
page 6 - 1 in the reminder of the User’s Manual. You may also find the notes marked with a  of interest to you.

Beginners and Not-So-Advanced Users
If you are new to computers (or do not have an advanced knowledge of them) then
the information contained in the Quick Start Guide should be enough to get you up
and running. Eventually you should try to look through all the documentation (more
detailed descriptions of the functions, setup and system controls are covered in the
remainder of the User’s Manual), but do not worry if you do not understand every-
thing the first time. Keep this manual nearby and refer to it to learn as you go. You
may find it useful to refer to the notes marked with a  as indicated in the margin.
For a more detailed description of any of the interface ports and jacks see “Interface
(Ports & Jacks)” on page  A - 1.

Warning Boxes
No matter what your level please pay careful attention to the warning and safety information indicated by the
 symbol. Also please note the safety and handling instructions as indicated in the Preface.


Notes

Check the light colored
boxes with the mark
above to find detailed in-
formation about the com-
puter’s features. 
1 - 2 Overview
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Not Included
Operating Systems (e.g. Windows 8.1) and applications (e.g. word processing, spreadsheet and database pro-
grams) have their own manuals, so please consult the appropriate manuals.



Drivers

If you are installing new system software, or are re-configuring your computer for a different system, you will need to install
the drivers listed in “Drivers & Utilities” on page 4 - 1. Drivers are programs which act as an interface between the com-
puter and a hardware component e.g. a wireless network module. It is very important that you install the drivers in the order
listed. You will be unable to use most advanced controls until the necessary drivers and utilities are properly installed. If
your system hasn’t been properly configured (your service representative may have already done that for you); refer to
Chapter 4 for installation instructions.

Ports and Jacks

See “Notebook Ports and Jacks” on page A - 2 for a description of the interface (ports & jacks) which allow your com-
puter to communicate with external devices, connect to the internet etc.
Overview 1 - 3
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System Startup
1. Remove all packing materials.
2. Place the computer on a stable surface.
3. Securely attach any peripherals you want to use with the notebook (e.g. keyboard and mouse) to their ports.
4. Attach the AC/DC adapter to the DC-In jack on the left of the computer, then plug the AC power cord into an

outlet, and connect the AC power cord to the AC/DC adapter.
5. Use one hand to raise the lid/LCD to a comfortable viewing angle (do not exceed 130 degrees); use the other

hand to support the base of the computer (Note: Never lift the computer by the lid/LCD).

Figure 1 - 1 - Opening the Lid/LCD & Computer with AC/DC Adapter Plugged-In

130°


Shutdown

Note that you should always
shut your computer down by
choosing the Shut Down
command in Windows (see
page 1 - 31). This will help
prevent hard disk or system
problems.
1 - 4 System Startup
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System Software
Your computer may already come with system software pre-installed. Where this is not the case, or where you
are re-configuring your computer for a different system, you will find the Windows 8.1 operating system is sup-
ported. 

Note: In order to run Windows without limitations or decreased performance, your computer requires a mini-
mum 1GB of system memory (RAM).


Windows Versions

Note that the information included on the following pages is for Windows 8.1 only.

The Windows 8 interface is slightly different in appearance and in methods of navigation, and a separate manual is pro-
vided on the Device Drivers & Manual Disc for Windows 8.

Windows OS

In order to run Windows 8/8.1 (32 Bit) without limitations or decreased performance, your computer requires a minimum
1GB of system memory (RAM), however if you are running Windows 8/8.1 (64 bit) your computer requires a minimum
2GB of system memory (RAM).
System Startup 1 - 5
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Model Appearance
This notebook series includes different models that vary slightly in design style, color and general appearance.
Not all the model variants, colors, configurations, buttons etc., are pictured in this manual. Note that though your
computer may look slightly different from that pictured throughout this manual, all ports, jacks and general func-
tions are the same for all the design styles.
1 - 6 System Startup
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LCD Panel Open Figure 1 - 2
LCD Panel Open

1. Built-in PC Camera 
2. PC Camera LED
3. Built-In Microphone
4. LCD
5. Power Button
6. Keyboard
7. Touchpad & 

Buttons (see over)

3

5

1

7

4

6

2 

Wireless Device 
Operation Aboard 

Aircraft

The use of any portable elec-
tronic transmission devices
aboard aircraft is usually pro-
hibited. Make sure the WLAN/
Bluetooth module(s) are OFF
if you are using the computer
aboard aircraft.

Use Fn + F11 Airplane Mode
key combination to toggle Air-
plane Mode On/Off, and
check the LED indicator for
the power status (see Table 1
- 3, on page 1 - 12/ Table 1 -
1, on page 1 - 9).
LCD Panel Open 1 - 7
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TouchPad/ClickPad Sensitivity
Note that the TouchPad/ClickPad has a defined valid operational area of sensitivity indicated within the area of
the illustration below (i.e. 4.4mm from the top and 4.9mm from the left/right sides of the TouchPad/Click-
Pad).

Figure 1 - 3 - TouchPad/ClickPad Sensitivity
1 - 8 LCD Panel Open
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LED Indicators
The LED indicators on the computer display helpful information about the current status of the computer.

Table 1 - 1 - LED Power Indicators

Icon Color Description

Orange DC Power is Plugged In

Green The Computer is On

Blinking Green The Computer is in Sleep Mode

Blinking Orange The Powered USB Port is On (see “Powered USB 3.0 Port” on page 1 - 15)

Orange The Battery is Charging

Green The Battery is Fully Charged

Blinking Orange The Battery Has Reached Critically Low Power Status

Green Hard Disk Activity

Green Airplane Mode is ON (the WLAN & Bluetooth Modules are OFF)
LED Indicators 1 - 9
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Keyboard
The keyboard has an embedded numerical keypad for easy numeric data input, and
function keys to change operational features instantly.

Figure 1 - 4 - Keyboard


Other Keyboards

If your keyboard is dam-
aged or you just want to
make a change, you can
use any standard USB
keyboard. The system will
detect and enable it auto-
matically. However spe-
cial functions/hot-keys
unique to the system’s
regular keyboard may not
work.

NumLk & ScrLk

Hold down the Fn Key
and either NumLk or
ScrLk to enable number
or scroll lock, and check
the LED indicator for sta-
tus.

Numerical 

Play/Pause Key

Function Keys

NumLk & 
ScrLk Keys

Fn Key

Keypad 

Windows Logo Key

Menu/Application Key



Special Characters

Some software applications allow the number-keys to be used with Alt to produce special characters.
These special characters can only be produced by using the numeric keypad. Regular number keys (in
the upper row of the keyboard) will not work. Make sure that NumLk is on.
1 - 10 Keyboard
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Keyboard Shortcuts
The following Windows Logo Key (Winkey) keyboard shortcuts are useful for navi-
gation/operation in Windows 8.1.

Table 1 - 2 - Keyboard Shortcuts

Windows Logo 

 Key + 
Description

Tap Winkey
Toggle between the Start screen and the foremost running app or the 

Windows Desktop

C Display Charms menu

D Switch to the Windows Desktop and toggle show Desktop 

E
 Switch to the Windows desktop and launch Windows Explorer with 

Computer displayed

F Display file Search

I Open the Settings charm

K Open the Connect charm

L Lock the computer and display the Lock screen

P  Display the Second Screen menu (see Figure 1 - 21 on page 1 - 28)

R Switch to the Windows Desktop and display the Run dialog box

Z Access the Customize Bar (see Figure 1 - 12 on page 1 - 20)


Windows Logo 

Keyboard Shortcut

Use the Windows logo
key  + D key com-
bination to switch be-
tween the Start screen
and Windows Desktop.

Menu/Application 
Keyboard Shortcut

When the Desktop app
is running you can use
the Menu/Application
key  on the key-
board to display the
context menu as per a
mouse right-click. In
the Start screen this
function is useful to
quickly display the All
Apps icon.
Keyboard 1 - 11
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Function/Hot Key Indicators
The function keys (F1 - F12 etc.) will act as hot keys when pressed while the Fn key is held down. In addition
to the basic function key combinations; visual indicators are available when the hot key utility is installed.

Table 1 - 3 - Function & Hot Key Indicators

Keys Function Keys Function

Fn + ~ Play/Pause (in Audio/Video Programs) Fn + F8/F9 Brightness Decrease/Increase 

Fn + F1 TouchPad Toggle Fn + F10 PC Camera Power Toggle 

Fn + F2
Turn LCD Backlight Off

(Press a key to or use TouchPad to turn on)
Fn + F11 Airplane Mode Toggle 

Fn + F3 Mute Toggle Fn + NumLk Number Lock Toggle 

Fn + F4 Sleep Toggle Fn + ScrLk Scroll Lock Toggle

Fn + F5/F6 Volume Decrease/Increase Caps Lock Caps Lock Toggle

Fn + F7 Display Toggle
Fn + Power 

Button
Powered USB Port - Toggle Power
1 - 12 Function/Hot Key Indicators
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Control Center
When in the Windows Desktop application (not in the Start screen) press the Fn + Esc key combination, or
double-click the icon  in the notification area of the taskbar to toggle the Control Center on/off. The Con-
trol Center gives quick access to frequently used controls and enables you to quickly turn the camera/Touch
Pad on/off (see Appendix B). 

Figure 1 - 5 - Control Center


Control Center

Click on any button to turn any of the modules (e.g.
TouchPad, Camera) on/off.

Click on the power conservation modes to switch be-
tween Performance, Balanced or Energy Star modes.
To remove the Power Conservation Modes screen
just click in a blank area of the icon or press a key on
the keyboard. 

Click on the buttons (or just click and hold the mouse
button) to adjust the slider for Brightness/Volume. 

Click on Display Switch and click to choose a display
mode from the menu (see page C - 18).
Control Center 1 - 13
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Front & Left ViewsFigure 1 - 6
Front & Left Views

1. LED Power 
Indicators

2. Vent/Fan Intake/
Outlet

3. DC-In Jack
4. RJ-45 LAN Jack
5. Mini Display Port
6. HDMI-Out Port



HDMI Port / Mini 
Display Port

Note that the HDMI Port
and Mini Display ports
support video and audio
signals to attached exter-
nal displays (see “HDMI
Audio Configuration”
on page C - 21).

2
63

1

2 54

4
4 4
1 - 14 Front & Left Views
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Right & Rear Views Figure 1 - 7
Right & Rear Views

1. Headphone-Out 
Jack

2. Microphone-In 
Jack

3. USB 3.0 Port
4. 1 * Powered (AC/

DC) USB 3.0 Port
5. Multi-in-1 Card 

Reader
6. Vent/Fan Intake/

Outlet
7. Security Lock Slot


Overheating

To prevent your comput-
er from overheating
make sure nothing
blocks the Vent/Fan In-
take while the computer
is in use.

7

42 51

W255EU

3
6

3

6

66



Multi-In-1 Card Reader

The card reader allows you to use the most popular digital storage card formats:

MMC (MultiMedia Card) / RS MMC
SD (Secure Digital) / Mini SD / SDHC / SDXC

Powered USB 3.0 Port

The powered USB 3.0  port can supply power (for charging devices only, not for
operating devices) when the system is off but still powered by the AC/DC adapter
plugged into a working outlet, or powered by the battery with a capacity level above 20%
(this may not work with certain devices - see page 7 - 10). Toggle power to this port by
using Fn + power button.

4

Right & Rear Views 1 - 15
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Bottom View Figure 1 - 8
Bottom View 

1. Vent/Fan Intake/
Outlet

2. Speakers



CPU

The CPU is not a user
serviceable part.

Overheating

To prevent your comput-
er from overheating
make sure nothing blocks
the Vent/Fan Intake while
the computer is in use.



Battery Information

Always completely discharge, then fully charge, a new battery before using it. Completely
discharge and charge the battery at least once every 30 days or after about 20 partial dis-
charges.

2

1 1

2

1 - 16 Bottom View
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Windows 8.1 Control Panel
Throughout this manual you will see an instruction to open the Control Panel.
Right-click the lower left hot corner to bring up the context menu (or use the Win-
dows Logo Key  + X key combination) and select Control Panel in both the
Desktop app or Start screen.

Figure 1 - 9 - Windows Context Menu


Windows Versions

Note that the informa-
tion included on the fol-
lowing pages is for
Windows 8.1 only.

The Windows 8 inter-
face is slightly different
in appearance and in
methods of navigation,
and a separate manual
is provided on the De-
vice Drivers & Manual
Disc with reference to
Windows 8.

 

   

Move the mouse to the bottom left 

   

Start ScreenDesktop app

of the screen and right-click to
access the menu. 
Windows 8.1 Control Panel 1 - 17
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Right-click the Start button in the Desktop app (or use the Windows Logo Key

 + X key combination) to bring up an advanced context menu of useful features
such as Control Panel, Programs and Features, Power Options, Task Manager,
Search, File Explorer, Command Prompt, Device Manager and Network Connec-
tions etc.

Figure 1 - 10 - Advanced Context Menu (Right-Click Start Button)


Display Most 

Recently Used 
Apps

If you are in the Start
screen, Desktop or an
app you can move your
mouse to the upper left
corner of the screen to
get back to the most re-
cently used app. 

To view all the most re-
cently used Apps hover
over the top left of the
screen and then move
the mouse down along
the left side of the
screen to display the
list.

Move the mouse to the bottom left of the screen 

and right-click the Start button to access the menu.
1 - 18 Windows 8.1 Control Panel
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Windows 8.1 Start Screen & Desktop
The Apps, control panels, utilities and programs within Windows are accessed from the Start screen and/or
Windows Desktop app. The Desktop (which runs as an app within the Start screen) can be accessed by clicking
the Desktop item in the Start screen (or by using the Windows Logo Key  + D key combination). Click the
arrow at the bottom of the Start screen to access Apps.

Figure 1 - 11 - Windows Start Screen

Desktop App
Windows 8.1 Start Screen & Desktop 1 - 19
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Apps & Tiles
The Start screen will contain a number of apps, and many more will be installed as you add more applications
etc. Not all of these apps can fit on one screen so you will often need use the slider at the bottom of the screen
in order to view all the necessary Apps.

Accessing Pining/Unpinning All Apps
You can add and remove the tiles for apps and control panels in the Start screen. Right-click on a blank area
of the Start screen, and you will see the Customize icon. Click the Customize icon to display all the installed
applications etc. Right-click any icon to bring up the menu at the bottom of the screen and you can then click the
appropriate icon to pin the App to (or unpin from) the Start screen, or to the taskbar in the Desktop applica-
tion (you can also open the app in a new window, run as administrator or open the file location).

Figure 1 - 12 - Customize Apps

 
 

Click the arrow at the bottom of the 
screen to access All Apps 
1 - 20 Windows 8.1 Start Screen & Desktop
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Desktop Application
When the Desktop app is running (click the app in the Start screen or use the Windows Logo Key  + D key
combination) you can use lower left hot corner to switch between the Start screen and the Windows Desktop
app. To do so move your mouse to hover over the bottom left corner of the Desktop app and left-click.

When you move to the lower left hot corner in the Start screen it will take you back to your most recently used
app (if one is running).

Figure 1 - 13 - Desktop

Move the mouse to the bottom left of the screen and click to switch
back to the Start screen.
Windows 8.1 Start Screen & Desktop 1 - 21
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The Charms Bar
The right side of the screen displays the Charms Bar. The Charms Bar contains the Search, Share, Start, De-
vices and Settings menus. To access up the Charms Bar move the cursor to the upper or lower right corners of
the screen, and then hover over one of the items in the Charms Bar to activate it (the bar will be black when it
is active), or use the Windows Logo Key  + C key combination. 

Figure 1 - 14 - Start Screen with Charms Bar

 

Move the mouse over a Charms Bar icon to activate the menu 

Move the mouse to the top/lower right icons to activate the Charms Bar 

Move the mouse to the top/lower right icons to activate the Charms Bar 
1 - 22 Windows 8.1 Start Screen & Desktop
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Charms Bar Items

• Search : You can search for any file, application, Apps and control panel settings with instantaneous 
results.

• Share : This button is used to share information with people via mail or social networks.

• Start : Click to bring up the Start screen (the same function as pressing the Windows Logo Key or click-
ing the bottom left of the screen). 

• Devices : Click this button to change connected peripheral device settings e.g. an external display.

• Settings : This button gives instant access to the computer settings, such as Network, Audio, Notifica-
tions, Power and Keyboard (click Change PC Settings to activate the PC Settings menu).

Figure 1 - 15 - Settings Menu


Charms Bar - TouchPad Access

To quick access the Charms Bar using the TouchPad:

1. Place your finger off the TouchPad (slightly to the right of the 
pad resting on the computer).

2. Move your finger across to the left on to the TouchPad.
3. The Charms Bar will then pop-up.
Windows 8.1 Start Screen & Desktop 1 - 23
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Windows 8.1 Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of ways in Windows 8.1.

• Click Search in the Windows Charms Bar (see previous page) and the search pane will pop out. Type 
Control Panel and select it from the results to the left.

Figure 1 - 16 - Search (Control Panel)

• Click on This PC (in Apps, or you can to pin This PC to the Start screen), click on Computer in the 
top menu and select Open Control Panel from the ribbon.

Figure 1 - 17 - Open Control Panel (Computer)
1 - 24 Windows 8.1 Control Panel
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• When in the Desktop app (this does not apply to the Start screen) click on Settings in the Windows 

Charms Bar and select Control Panel from the menu.

Figure 1 - 18 - Settings Charms Bar (Desktop App Only)

• Click the arrow at the bottom of the Start screen and click Control Panel in Apps (Windows System).

Figure 1 - 19 - All Apps - Control Panel
Windows 8.1 Control Panel 1 - 25
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• Right-click the Start button to bring up the menu and select Control Panel (see Figure 1 - 10 on page 1 

- 18).


Keyboard Shortcut to Control Panel

You can also use keyboard shortcuts to access the Control Panel. Press the Windows logo key  and X to bring up
the context menu, and then press P to bring up the Control Panel. Alternatively press the Windows logo key  and R
to bring up the Run dialog box, and then type “Control Panel” and press Enter to access the Control Panel.
1 - 26 Windows 8.1 Control Panel
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Windows 8.1 Taskbar
In many instances throughout this manual you will see an instruction to access the notification area of the task-
bar (system tray). In Windows 8.1 the taskbar is accessed from the Desktop application; if you are in the Start
screen you will need to switch to the Desktop.

The taskbar is displayed at the bottom of the Desktop screen, and you can see the notification area (system
tray) of the taskbar in the bottom right of the screen. Some of the control panels and applications referred to
during the course of this manual can be accessed from here.

Figure 1 - 20 - Desktop Taskbar & Notification Area (System Tray)

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Accessing
Pining/Unpinning All Apps” on page 1 - 20).
Windows 8.1 Control Panel 1 - 27
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Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearances
and Personalization) in Windows when running the Desktop app (see “Desktop Application” on page 1 - 21).
It is possible to quickly configure external displays from the Devices menu item in the Charms Bar (see “The
Charms Bar” on page 1 - 22).

To Configure Displays from Devices (Charms Bar):
1. Attach your display to the appropriate port, and turn it on.
2. Go the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only, Duplicate, Extend or Second screen

only.

Figure 1 - 21 - Devices (Project)
1 - 28 Video Features
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To access Display (Control Panel) and Screen Resolution in Windows 8:
1. Go to the Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Adjust resolution.

Figure 1 - 22 - Screen Resolution

1

3

2


Right-Click Desktop App

1. You can right-click the 
desktop and select 
Screen resolution 

 (Figure 1 - 22).
2. Use the dropbox to 

select the screen 
Resolution  
(Figure 1 - 22).

3. Click Advanced 
settings  (Figure 
1 - 22) to bring up the 
Advanced properties 
tabs.

1

2

3
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To access the Intel(R) Graphics Control Panel:
(For All Models)
1. Click Advanced settings  (Figure 1 - 22 on page 1 - 29) in the Screen Resolution control panel in Win-

dows.
2. Click the Intel(R)... tab and click Graphics Properties (button)  (Figure 1 - 23 on page 1 - 30) .
OR
3. Right-click the desktop and select Graphics Properties from the menu.
OR
4. Click the icon  in the notification area of the Desktop taskbar and select Graphics Properties from the menu.

Figure 1 - 23 - Intel Graphics Control Panel

3

4

4
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Power Options
Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power Menu item in Set-
tings in the Charms Bar in Windows 8.1 may be used to Shut down or Restart (you can also add Hibernate/
Sleep to the menu - see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10). You can also use the
context menu (Shut down or sign out) shut the computer down/restart etc.

Shut Down, Restart or Sleep (Charms Bar)
1. Go to the Charms Bar and click Settings.
2. Click Power .
3. Select Sleep, Shut Down or Restart.

Figure 1 - 24 - Shut Down/Restart 

Charms Bar Desktop App Start Screen
Power Options 1 - 31
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Running Apps
To run apps in Windows 8.1 you will need to check that the Screen Resolution and User Account Control Set-
tings are compatible with the system requirements.

Screen Resolution Settings
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + D key combination).
2. Right-click a blank area of the Windows Desktop and select Screen Resolution. Adjust the Resolution to

make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above (see sidebar).

Figure 1 - 25 - Screen Resolution


Screen Resolution for Apps 

(Windows 8/8.1)

The minimum resolution in which Apps will run is 1024x768. 

The minimum resolution required to support all the features of
Windows 8 (including multitasking with snap) is 1366x768. 

These specs are the minimum screen resolution that supports
all the features of Windows 8.1 on a useful physical size. 
1 - 32 Running Apps
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User Account Control Settings
If your computer meets the minimum screen resolution requirements, and still you can't run apps, then that you
have to check the status of User Account Control (UAC). Apps may fail to open when the UAC is turned off.
To check whether the UAC is on or off, follow the instructions below.

1. Open the Control Panel.
2. Click on User Accounts and then click on Change User Account Control settings (or click System and

Security and click Change User Account Control Settings under Action Center).
3. If the slider is in the Never notify position, then the UAC is disabled. 
4. To enable or turn on the UAC, move the slider to Always notify or Notify me when apps try to make changes

to my computer (default) position, and then click OK. 

Figure 1 - 26 - User Account Control
Running Apps 1 - 33
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Chapter 2: Features & Components

Overview
Read this chapter to learn more about the following main features and components
of the computer:

• Hard Disk Drive
• Multi-In-1 Card Reader
• TouchPad and Buttons/Mouse
• Audio Features
Overview 2 - 1
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 Hard Disk Drive
The hard disk drive is used to store your data in the computer. The hard disk can be
taken out to accommodate other serial (SATA) hard disk drives (see “Storage” on
page D - 2 for specification information), however you will need to contact your dis-
tributor/supplier to do this in order to avoid violating the terms of your warranty.


Bottom Cover 

Removal Warning

Do not remove any cov-
er(s) and /or screw(s) for
the purposes of device
upgrade as this may vio-
late the terms of your
warranty.

If you need to replace/
remove the hard disk for
any reason, please con-
tact your distributor/sup-
plier for further
information.
2 - 2 Hard Disk Drive



Features & Components

2
Multi-In-1 Card Reader
The card reader allows you to use some of the latest digital storage cards. Push the
card into the slot and it will appear as a removable device, and can be accessed in
the same way as your hard disk (s). Make sure you install the card reader driver (see
“CardReader” on page 4 - 7.

Note: Some of these cards require PC adapters that are usually supplied with the
cards.


Card Reader Cover

Make sure you keep the
rubber cover provided in
the card reader when
not in use. This will help
prevent foreign objects
and/or dust getting in to
the card reader.

 Figure 2 - 1
Right View

1. Card Reader

• MMC (MultiMedia Card) / RS MMC
• SD (Secure Digital) / Mini SD / SDHC / SDXC

1

Multi-In-1 Card Reader 2 - 3
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 TouchPad and Buttons/Mouse
The TouchPad/ClickPad is an alternative to the mouse; however, you can also add a
mouse to your computer through one of the USB ports. The TouchPad/ClickPad but-
tons function in much the same way as a two-button mouse.

TouchPad/ClickPad Sensitivity
Note that the TouchPad/ClickPad has a defined valid operational area of sensitivity
indicated within the area of the illustration below (i.e. 4.4mm from the top and
4.9mm from the left/right sides of the TouchPad/ClickPad).


Mouse Driver

If you are using an ex-
ternal mouse your op-
erating system may be
able to auto-configure
your mouse during its
installation or only en-
able its basic functions.
Be sure to check the
device’s user docu-
mentation for details.

 Figure 2 - 2
TouchPad/
ClickPad 

Sensitivity
2 - 4 TouchPad and Buttons/Mouse
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Once you have installed the TouchPad driver (see “Touchpad” on page 4 - 7) you
can configure the functions from the Mouse control panel in Windows, or by double-
clicking the driver icon  in the notification area of the taskbar in the Desktop app.
You may then configure the tapping, buttons, scrolling, pointer motion and sensitiv-
ity options to your preferences. You will find further information at www.synap-
tics.com.


Scrolling

This computer model se-
ries may feature different
TouchPad/ClickPad ver-
sions.

These TouchPads/Click-
Pads may differ in their
vertical scrolling function
in most scrollable win-
dows.

Some TouchPads/Click-
Pads require sliding the
finger up and down on the
right of the TouchPad/
ClickPad to scroll the win-
dow. Other versions re-
quire tapping/holding
down the finger at the top
right or bottom right of the
TouchPad/ClickPad to
scroll the window.

 Figure 2 - 3
Mouse Properties
TouchPad and Buttons/Mouse 2 - 5
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Gestures and Device Settings
The Synaptics Gestures Suite application allows you to use a specific gesture (ac-
tion) on the surface of the Touchpad/ClickPad to perform specific actions to manip-
ulate documents, objects and applications.

You can configure the settings from the Device Settings tab in Mouse Properties:

1. Go to the Control Panel.
2. Click Mouse (Hardware and Sound).
3. Click Device Settings (tab) and click Settings.
4. Use the menu tree on the left to access the user configurable settings.


Show Video

You can get a clearer
view of the gestures in-
volved by clicking the
Show Video option for
each gesture item.

Select the gesture (Pinch
Zoom, Rotating, Three
Fingers Down and
Three Finger Flick) in the
Device Settings > Set-
tings left tree menu
and click the Show Video
button to see the demon-
stration video.

For more details on any of
the gestures see the help
in the lower part of the
right menu window.

 Figure 2 - 4
Mouse Properties - 

Device Settings
2 - 6 TouchPad and Buttons/Mouse
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Disabling the Touchpad
If you need to disable the TouchPad/ClickPad for any reason (e.g. you may find that
when using the computer’s internal keyboard you accidentally trigger the TouchPad/
ClickPad when resting your wrists or palms on it) you can do so by using Fn + F1
key combination.

You can also set the system to automatically disable the internal TouchPad/ClickPad
when an external USB point device (e.g a USB mouse) is attached.

1. Go to the Mouse Properties control panel.
2. Click to select Device Settings (tab).
3. Click to place a tick in the “Disable internal pointing device when external USB 

pointing device is attached” tickbox.
4. Click OK to save the setting.

 Figure 2 - 5
Mouse Properties 
(Disable Internal 
Pointing Device) 
TouchPad and Buttons/Mouse 2 - 7
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Scrolling
The Two-Finger scrolling feature works in most scrollable windows and allows you
to scroll horizontally and vertically. Place two fingers, slightly separated, on the pad
surface and slide both fingers in the direction required (in a straight continuous mo-
tion).

Zooming
The Pinch Zoom gesture can be used to perform the same function as a scroll wheel
in Windows applications that support CTRL + scroll wheel zoom functionality.
Place two fingers on the pad (for best results use the tips of the fingers) and slide
them apart to zoom in, or closer together to zoom out.

 Figure 2 - 6
Scrolling Gesture

 Figure 2 - 7
Zooming Gesture
2 - 8 TouchPad and Buttons/Mouse
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Rotating
Use the Pivot Rotate gesture to rotate objects (e.g. photos) in 90 degree increments.
Place a finger down on the left “target” zone and keep it stationary. Place another
finger near the middle of the pad and slide it in a circular motion around the station-
ary finger (clockwise or counterclockwise) to rotate the object.

Three Finger-Flick/Three Fingers Down (Press)
The Three Finger-Flick gesture may be used to enhance navigation with a variety of
applications such as browsing the Internet or scrolling through a photo viewer. The
Three Fingers Down gesture may be used to launch user-selectable applications.

 Figure 2 - 8
Rotating Gesture

 Figure 2 - 9
Flick/Press 

Gesture
TouchPad and Buttons/Mouse 2 - 9
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 Audio Features
You can configure the audio options on your computer from the Sound  control
panel in Windows, from the HD VDeck icon on the desktop  or VIA HD Audio
Deck control panel .

The volume may also be adjusted by means of the Fn + F5/F6 key combination. 


Sound Volume 

Adjustment

The sound volume level
is set using the volume
control within Windows
(and the volume func-
tion keys on the comput-
er). Click the volume
icon in the taskbar to
check the setting.

 Figure 2 - 10
VIA HD Audio Deck

Click Expert Mode to access the Advanced menus 
2 - 10 Audio Features
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Expert Mode will allow you to access more advanced configuration menus for
Speaker, Microphone and Stereo Mix. 

Syncing Left & Right 
Volume 
Balance

If you wish to adjust the left
and right channel volume
levels separately, you will
need to adjust this from the
VIA HD Audio Deck in Ex-
pert Mode.

Click Speaker in VIA HD
Audio Deck (in Expert
Mode) and click the Sync
Left and Right volume
button (see left). You can
then adjust the volume slid-
ers independently (this set-
ting also controls the
Balance setting in the Win-
dows Sound control pan-
el).

 Figure 2 - 11
VIA HD Audio Deck 

(Expert Mode)

Note that to adjust the Left & Right volume balance independently click the Sync
Left and Right Volume icon (it should be faded) and adjust the slider as required. 
Audio Features 2 - 11
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Chapter 3: Power Management

Overview
To conserve power, especially when using the battery, your computer power man-
agement conserves power by controlling individual components of the computer
(the monitor and hard disk drive) or the whole system. This chapter covers:

• The Power Sources
• Turning On the Computer
• Power Plans
• Power-Saving States
• Configuring the Power Buttons
• Battery Information

The computer uses enhanced power saving techniques to give the operating system
(OS) direct control over the power and thermal states of devices and processors. For
example, this enables the OS to set devices into low-power states based on user set-
tings and information from applications.


OS Note

Power management
functions will vary slight-
ly depending on your
operating system. For
more information it is
best to refer to the user’s
manual of your operat-
ing system.
Overview 3 - 1
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The Power Sources
The computer can be powered by either an AC/DC adapter or a battery pack.

AC/DC Adapter
Use only the AC/DC adapter that comes with your computer. The wrong type of AC/
DC adapter will damage the computer and its components.

1. Attach the AC/DC adapter to the DC-in jack on the left of the computer.
2. Plug the AC power cord into an outlet, and then connect the AC power cord to the 

AC/DC adapter.
3. Raise the lid/LCD to a comfortable viewing angle.
4. Press the power button to turn “On”.

Battery
The battery allows you to use your computer while you are on the road or when an
electrical outlet is unavailable. Battery life varies depending on the applications and
the configuration you're using. To increase battery life, let the battery discharge
completely before recharging (see “Battery FAQ” on page 3 - 18).

We recommend that you do not remove the battery. For more information on the bat-
tery, please refer to “Battery Information” on page 3 - 14.


Forced Off

If the system “hangs”,
and the Ctrl + Alt + Del
key combination doesn’t
work, press the power
button for 4 seconds, or
longer, to force the sys-
tem to turn itself off.
3 - 2 The Power Sources
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Turning On the Computer
Now you are ready to begin using your computer. To turn it on simply press the pow-
er button on the front panel.

When the computer is on, you can use the power button as a Stand by/Hibernate/
Shutdown hot-key button when it is pressed for less than 4 seconds (pressing and
holding the power button for longer than this will shut the computer down). Use
Power Options (Hardware and Sound) in the Windows control panel to configure
this feature.


Power Button as Stand by or Hibernate Button

You can use the OS’s “Power Options” control panel to set the power button to send the
system into Stand by or Hibernate mode (see your OS’s documentation, or “Configuring
the Power Buttons” on page 3 - 9 for details).
Turning On the Computer 3 - 3
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Shutting the Computer Down
Note that you should always shut your computer down by choosing the Shut down
command as this will help prevent hard disk or system problems. Use the Shut down
or sign out item in the Context Menu (right-click the lower left corner of the screen
to bring up the menu).

You can also use the Power Menu in Settings in the Windows 8.1 Charms Bar. If
you want to add Hibernate/Sleep to the Power Menu see “Adding Hibernate/Sleep
to the Power Menu” on page 3 - 10.

Figure 3 - 1
Shut Down/Restart

Charms Bar Desktop App Start Screen
3 - 4 Shutting the Computer Down
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Power Plans
The computer can be configured to conserve power by means of power plans. You
can use (or modify) an existing power plan, or create a new one.

The settings may be adjusted to set the display to turn off after a specified time, and
to send the computer into Sleep after a period of inactivity. 

Click Change plan settings and then click Change advanced power settings to ac-
cess further configuration options in Advanced Settings.


Resuming 
Operation

See Table 3 - 1, on
page 3 - 11 for informa-
tion on how to resume
from a power-saving
state.

Password

It is recommended that
you enable a password
on system resume in or-
der to protect your data.

Figure 3 - 2
Power Plan 

Advanced Settings
Power Plans 3 - 5
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Each Windows power plan will also adjust the processor performance of your ma-
chine in order to save power. This is worth bearing in mind if you are experiencing
any reduced performance (especially under DC/battery power).

Choose High performance (you may need to click Show additional plans to view
the High performance plan) for maximum performance when the computer is pow-
ered from an AC power source. Choose the Power saver (bear in mind that this
scheme may slow down the overall performance of the computer in order to save
power) for maximum power saving when the computer is battery (DC power) pow-
ered.

Figure 3 - 3
Power Plans

Click to Show/Hide 
additional 
power plans
3 - 6 Power Plans
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Power-Saving States
You can use power-saving states to stop the computer’s operation and restart where
you left off. Win 8.1 uses the Sleep, Hibernate and Shut Down power-saving
states.

Sleep
In Sleep all of your work, settings and preferences are saved to memory before the
system sleeps. When you are not using your computer for a certain length of time,
which you specify in the operating system, it will enter Sleep to save power. 

The PC wakes from Sleep within seconds and will return you to where you last left
off (what was on your desktop) without reopening the application(s) and file(s) you
last used.

If your mobile PC in Sleep is running on battery power the system will use only a
minimum amount of power. After an extended period the system will save all the
information to the hard disk and shut the computer down before the battery becomes
depleted.

To add Sleep to the Power Menu see “Adding Hibernate/Sleep to the Power
Menu” on page 3 - 10.


Wake On LAN 

Support 

Wake-On-LAN is only
supported from Sleep or
Hibernate states in
Windows .

If you require your com-
puter to wake up from
network activity in Win-
dows then make sure
that the computer is ei-
ther in Sleep or Hiber-
nate.

Wake-On-LAN is not
supported from Shut-
down states in Win-
dows.
Power-Saving States 3 - 7
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Hibernate
Hibernate uses the least amount of power of all the power-saving states and saves
all of your information on a part of the hard disk before it turns the system off. If a
power failure occurs the system can restore your work from the hard disk; if a power
failure occurs when work is saved only to memory, then the work will be lost. Hi-
bernate will also return you to where you last left off within seconds. You should
put your mobile PC into Hibernate if you will not use the computer for a period of
time, and will not have the chance to charge the battery. To add Hibernate to the
Power Menu see “Adding Hibernate/Sleep to the Power Menu” on page 3 - 10.

Shut down
You should Shut down the computer if you plan to install new hardware (don’t for-
get to remove the battery and follow all the safety instructions in Chapter 6), plan
to be away from the computer for several days, or you do not need it to wake up and
run a scheduled task. Returning to full operation from Shut down takes longer than
from Sleep or Hibernate.

Figure 3 - 4
Power Menu
3 - 8 Power-Saving States
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Configuring the Power Buttons
The power/sleep button (Fn + F4 key combo) and closed lid may be set to send the
computer in to a power-saving state. Click Choose what the power buttons do on
the left menu in Power Options to bring up the menu.


Password 
Protection

It is recommended that
you enable a password
on wake up in order to
protect your data.

However you can dis-
able this setting from the
Power Options menu
by clicking Require a
password on wakeup
in the left menu, and se-
lecting the options (click
Change settings that
are currently unavail-
able).

Figure 3 - 5
Power Options 
Define Power 

Buttons
Configuring the Power Buttons 3 - 9
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Adding Hibernate/Sleep to the Power Menu
Add Hibernate/Sleep to the Power Menu as follows.

1. Go to the Power Options (Hardware and Sound) control panel.
2. Click “Change settings that are currently unavailable” .
3. Click Choose what the power buttons do.
4. Click to put a tick in the Hibernate/Sleep box under Shutdown settings.
5. Click Save Changes and close the control panel.

Figure 3 - 6
Power Options 
Define Power 

Buttons - Shutdown 
Settings
3 - 10 Configuring the Power Buttons
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Resuming Operation
You can resume operation from power-saving states by pressing the power button,
or in some cases pressing the sleep button (Fn + F4 key combo).

Power Status Icon  Color To Resume

Power Off Off Press the Power Button

Sleep Blinking Green
Press the Power Button

Press the Sleep Button (Fn + F4 Key Combo)

Hibernate
Off (battery)

Press the Power Button
Orange (AC/DC adapter)

Display Turned Off Green Press a Key or Move the Mouse/Touchpad

Table 3 - 1
Resuming 

Operation


Closing the Lid

If you have chosen to
send the computer to
Sleep when the lid is
closed, raising the lid
will wake the system up.


Power Button

When the computer is on, you can use the power button as a Sleep/Hibernate/Shut Down
hot key button when it is pressed for less than 4 seconds (pressing and holding the power
button for longer than this will force the computer to shut down).
Configuring the Power Buttons 3 - 11
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Power Conservation Modes
This system supports Energy Star power management features that place comput-
ers (CPU, hard drive, etc.) into a low-power sleep modes after a designated period
of inactivity. Adjust Power Conservation Modes from the Control Center:

1. Press the Fn + Esc key combination to toggle the Control Center on/off.
2. Click either the Performance, Balanced or Energy Star button.
3. Click in a blank area of the icon or press a key on the keyboard to exit Power 

Conservation Mode without making any changes.


Power Conservation 

Modes

The Energy Star setting
will result in maximum
power saving, but with
the possible loss of
some performance.

Setting the mode to Bal-
ance will give power
saving matched with
performance. 

Performance will give
optimum computer per-
formance but with less
power conservation.

Figure 3 - 7
Control Center


Energy Star

Display Sleep Mode

Note that the Energy Star
setting will put the display
into sleep after no more than
15 minutes of user inactivity.
3 - 12 Configuring the Power Buttons
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Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination from almost any of the Win-
dows 8 interfaces/Apps to bring up a full-screen displaying Lock, Switch User, Log
off, Change a password and Task Manager options. If you click the Power icon
in the lower right corner of the screen a power management option menu appears to
display Sleep, Shut down, and Restart.

To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to per-
form the function selected.

Figure 3 - 8
Ctrl + Alt + Delete 

Menu
Configuring the Power Buttons 3 - 13
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Battery Information
Follow these simple guidelines to get the best use out of your battery.

Battery Power
Your computer’s battery power is dependent upon many factors, including the pro-
grams you are running, and peripheral devices attached. You can set actions to be
taken (e.g. Shut down, Hibernate etc.), and set critical and low battery levels from
power plan Change plan settings > Change advanced power settings (see Figure
3 - 3 on page 3 - 6).

Click the battery icon  in the notification area to see the current battery level and
charge status.


Low Battery 

Warning

When the battery is criti-
cally low, immediately
connect the AC/DC
adapter to the computer
or save your work, oth-
erwise, the unsaved
data will be lost when
the power is depleted.

Figure 3 - 9
Battery Icon 

(Notification Area) & 
Battery Advanced 

Settings
3 - 14 Battery Information
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Conserving Battery Power
• Use a power plan that conserves power (e.g Power saver), however note that 

this may have an affect on computer performance.

• Lower the brightness level of the LCD display. The system will decrease LCD 
brightness slightly to save power when it is not powered by the AC/DC adapter.

• Reduce the amount of time before the display is turned off.

• Close wireless, Bluetooth, modem or communication applications when they are 
not being used.

• Disconnect/remove any unnecessary external devices e.g. USB devices, 
ExpressCards etc.


Windows Mobility 

Center

The Windows Mobility
Center control panel
provides an easy point
of access for information
on battery status, power
plans used and wireless
device status etc.

Figure 3 - 10
Windows Mobility 

Center
Battery Information 3 - 15
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Battery Life
Battery life may be shortened through improper maintenance. To optimize the life
and improve its performance, fully discharge and recharge the battery at least
once every 30 days.

We recommend that you do not remove the battery yourself. If you do need to re-
move the battery for any reason (e.g. long term storage) see “Removing the Battery”
on page 6 - 3.

New Battery
Always completely discharge, then fully charge, a new battery (see “Battery FAQ”
on page 3 - 18 for instructions on how to do this).

Recharging the Battery with the AC/DC Adapter
The battery pack automatically recharges when the AC/DC adapter is attached and
plugged into an electrical outlet. If the computer is powered on, and in use, it will
take several hours to fully recharge the battery. When the computer is turned off but
plugged into an electrical outlet, battery charge time is less. Refer to “LED Indica-
tors” on page 1 - 9 for information on the battery charge status, and to “Battery In-
formation” on page 3 - 14 for more information on how to maintain and properly
recharge the battery pack.
3 - 16 Battery Information
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Proper handling of the Battery Pack
• DO NOT disassemble the battery pack under any circumstances
• DO NOT expose the battery to fire or high temperatures, it may explode
• DO NOT connect the metal terminals (+, -) to each other


Caution

Danger of explosion if
battery is incorrectly re-
placed.

Replace only with the
same or equivalent type
recommended by the
manufacturer. Discard
used battery according
to the manufacturer’s in-
structions.


Damaged Battery Warning

Should you notice any physical defects (e.g. the battery is bent out of shape after being
dropped), or any unusual smells emanating from the notebook battery, shut your computer
down immediately and contact your distributor/supplier. If the battery has been dropped we
do not recommend using it any further, as even if the computer continues to work with a
damaged battery in place, it may cause circuit damage, which may possibly result in fire. It
is recommended that you replace your computer battery every two years.
Battery Information 3 - 17
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Battery FAQ
How do I completely discharge the battery?
Use the computer with battery power until it shuts down due to a low battery. Don’t
turn off the computer even if a message indicates the battery is critically low, just let
the computer use up all of the battery power and shut down on its own.

1. Save and close all files and applications.
2. Create a power plan for discharging the battery and set all the options to Never.

Figure 3 - 11
Power Plan Create
3 - 18 Battery Information
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3. Click Change plan settings (after creating it) and click Change plan settings > 
Change advanced power settings.

Figure 3 - 12
Change Plan 

Settings / Change 
Advanced Power 

Settings
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4. Scroll down to Battery and click + to expand the battery options.
5. Choose the options below (click Yes if a warning appears):

• Low battery levels = 0%
• Critical battery Levels = 1%
• Low battery action = Do Nothing
• Critical battery action (On battery) = Shut Down
• Critical battery action (Plugged in) = Do Nothing

Figure 3 - 13
Power Options 

Advanced Settings - 
Battery
3 - 20 Battery Information
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How do I fully charge the battery?
When charging the battery, don’t stop until the LED charging indicator light changes
from orange to green.

How do I maintain the battery?
Completely discharge and charge the battery at least once every 30 days or after
about 20 partial discharges.
Battery Information 3 - 21
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Chapter 4: Drivers & Utilities
This chapter deals with installing the drivers and utilities essential to the operation or
improvement of some of the computer’s subsystems. The system takes advantage of
some newer hardware components for which the latest versions of most available op-
erating systems haven’t built in drivers and utilities. Thus, some of the system com-
ponents won’t be auto-configured with an appropriate driver or utility during
operating system installation. Instead, you need to manually install some system-re-
quired drivers and utilities. 

What to Install
The Device Drivers & Utilities + User’s Manual disc contains the drivers and util-
ities necessary for the proper operation of the computer. Table 4 - 1, on page 4 - 4
lists what you need to install and it is very important that the drivers are installed
in the order indicated.

Note that the information included on the following pages is for Windows 8.1 only.
For Windows 10 driver installation see “Windows 10 Drivers & Utilities” on page E
- 15.

Module Driver Installation
The procedures for installing drivers for the PC Camera, Wireless LAN, Bluetooth
& WLAN Combo, Intel Technology, Sound Blaster Cinema and 3G modules are
provided in “Modules & Options” on page 6 - 1.


Driver Installation & 

Power

When installing driv-
ers make sure your
computer is powered
by the AC/DC adapter
connected to a work-
ing power source.
Some drivers draw a
significant amount of
power during the instal-
lation procedure, and if
the remaining battery
capacity is not adequate
this may cause the sys-
tem to shut down and
cause system problems
(note that there is no
safety issue involved
here, and the battery will
be rechargeable within 1
minute).
What to Install 4 - 1
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Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.
4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.

Figure 4 - 1 - Drivers Installer Screen 1
4 - 2 Driver Installation
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5. Check the driver installation order from Table 4 - 1, on page 4 - 4 (the drivers must be installed in this order) 
which is the same as that listed in the Drivers Installer menu below.

6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the following pages.

Figure 4 - 2 - Install Drivers
Driver Installation 4 - 3
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Table 4 - 1 - Driver Installation

All drivers provided are for the Windows 8.1 (64 bit) operating system.

Note that you need to install both the WLAN & Bluetooth drivers for Intel and 3rd party WLAN & Bluetooth
Combo modules.

Win 8.1 (64 bit) Driver Page # Win 8.1  - Optional Items Page #

Chipset Page 4 - 7 PC Camera Module (No driver required for Windows 8.1) Page 6 - 2

Video (VGA) Page 4 - 7 Wireless LAN Module Page 6 - 11

LAN Page 4 - 7 Bluetooth & WLAN Combo Module Page 6 - 16

CardReader Page 4 - 7 Trusted Platform (Security) Module Page 6 - 21

Touchpad Page 4 - 7
Intel® Rapid Storage Technology (required for hard disks in 
AHCI/RAID mode and for Intel® Smart Response Technology)

Page 6 - 35 &
Page 6 - 36

Airplane Page 4 - 7 Intel® Rapid Start Technology Driver Page 6 - 40

Hot Key Page 4 - 8 Wireless Display Page 6 - 48

MEI Driver Page 4 - 8

Audio Page 4 - 8
4 - 4 Driver Installation
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Manual Driver Installation
Click Browse CD/DVD (button) in the Drivers Install-
er application and browse to the executable file in the
appropriate driver folder.

Windows Update
After installing all the drivers make sure you enable
Windows Update in order to get all the latest security
updates etc. (all updates will include the latest hotfixes
from Microsoft). See “Windows Update” on page 4 -
9 for instructions.

Updating/Reinstalling Individual Drivers
If you wish to update/reinstall individual drivers it
may be necessary to uninstall the original driver.To do
this go to the Control Panel in the Windows OS and
double-click the Programs and Features icon (Pro-
grams > Uninstall a program). Click to select the
driver (if it is not listed see below) and click Uninstall,
and then follow the on screen prompts (it may be nec-
essary to restart the computer). Reinstall the driver as
outlined in this chapter.

If the driver is not listed in the Programs and Fea-
tures menu:

1. Go to the Control Panel).
2. Double-click Device Manager (Hardware and 

Sound > Devices and Printers > Device 
Manager).

3. Double-click the device you wish to update/reinstall 
the driver for (you may need to click “+” to expand 
the selection).

4. Click Driver (tab) and click the Update Driver or 
Uninstall button and follow the on screen prompts.
Driver Installation 4 - 5
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User Account Control
If a User Account Control prompt appears as part of
the driver installation procedure, click Continue or
Allow, and follow the installation procedure as direct-
ed.

Windows Security Message
If you receive a Windows security message as part of
the driver installation process. Just click “Install this
driver software anyway” or “Install” to continue the
installation procedure.

You will receive this message in cases where the driv-
er has been released after the version of Windows you
are currently using. All the drivers provided will have
already received certification for Windows.

New Hardware Found
If you see the message “New Hardware Found” dur-
ing the installation procedure (other than when out-
lined in the driver install procedure), click Cancel
to close the window, and follow the installation proce-
dure.


Driver Installation General Guidelines

The driver installation procedure outlined in this Chapter
(and in Chapter 7 Options & Modules), are accurate at
the time of going to press.

Drivers are always subject to upgrade and revision so
the exact procedure for certain drivers may differ slight-
ly. As a general guide follow the default on screen in-
structions for each driver (e.g. Next > Next > Finish)
unless you are an advanced user. In many cases a re-
start is required to install the driver.

Make sure any modules (e.g. WLAN or Bluetooth) are
ON (i.e. the system is not in Airplane Mode) before
installing the appropriate driver.
4 - 6 Driver Installation
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

LAN
1. Click 3.Install LAN Driver > Yes.
2. Click Install Drivers and Software > Next.
3. Click the button to accept the license and click 

Next.
4. Click Next > Install.
5. Click Finish.

CardReader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad
1. Click 5.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license agreement 

and click Next.
4. Click Finish > Restart Now to restart the com-

puter.

Airplane
Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

1. Click 6.Install Airplane Mode AP > Yes. 
2. Click Next.
3. Click Finish to restart the computer.
Driver Installation 4 - 7
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Hot Key
1. Click 7.Install Hotkey AP > Yes. 
2. Click Next > Next.
3. Click Finish > Finish to restart the computer.

MEI Driver
1. Click 8.Install MEI Driver > Yes.
2. Click Next > Yes > Next.
3. Click Finish to restart the computer.

Audio
1. Click 9.Install Audio Driver > Yes. 
2. Click Next.
3. Click the button to agree to the license and 

click Next.
4. Click Next > Next > Next.
5. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.

It is recommended you now also install the Intel Rap-
id Storage Technology driver (see “Intel® Rapid
Storage Technology” on page 6 - 35 - required for
AHCI mode hard disks).

(see over)
4 - 8 Driver Installation
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
Windows Update

After installing all the drivers make sure you enable Win-
dows Update in order to get all the latest security up-
dates etc. (all updates will include the latest hotfixes
from Microsoft).

To enable Windows Update make sure you are con-
nected to the internet:

1. Go to the Control Panel.
2. Click Windows Update (System and Security/

Security).
3. Click Check for updates (button).
4. The computer will now check for updates (you 

need to be connected to the internet).
5. Click Install now (button) to begin checking for the 

updates.
6. Click Install updates (button) to install the 

updates.
Driver Installation 4 - 9
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Optional Drivers
See the pages indicated in Table 4 - 1, on page 4 - 4 for the driver installation procedures for any modules in-
cluded in your purchase option.

Figure 4 - 3 - Option Drivers

Note that you need to install both the WLAN & Bluetooth drivers for Intel and 3rd party WLAN & Bluetooth
Combo modules.
4 - 10 Optional Drivers
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Chapter 5: BIOS Utilities

Overview
This chapter gives a brief introduction to the computer’s built-in software: 

If your computer has never been set up, or you are making important changes to the
system (e.g. hard disk setup), then you should review this chapter first and note the
original settings found in Setup. Even if you are a beginner, keep a record of the set-
tings you find and any changes you make. This information could be useful if your
system ever needs servicing.

There is one general rule: Don’t make any changes unless you are sure of what you
are doing. Many of the settings are required by the system, and changing them could
cause it to become unstable or worse. If you have any doubts, consult your service
representative.


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
Overview 5 - 1
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The Setup Utility
Each time you turn on the computer the system takes a few seconds to conduct a
POST, including a quick test of the on-board RAM (memory).

As the POST proceeds, the computer will tell you if there is anything wrong. If there
is a problem that prevents the system from booting, it will display a system summary
and prompt you to run Setup. 

If there are no problems, the Setup prompt will disappear and the system will load
the operating system. Once that starts, you can’t get into Setup without rebooting.

The Aptio Setup Utility tells the system how to configure itself and manage basic
features and subsystems (e.g. port configuration).

To enter Setup, turn on the computer and press F2 (give the system a few seconds
to enter Setup). If the Boot Logo is enabled the F2 on screen will be highlighted to
illustrate that the system is processing the request during the POST (or press F7 for
boot options). If you get a “Keyboard Error”, (usually because you pressed F2 too
quickly) just press F2 again.

If the computer is already on, reboot using the Ctrl + Alt + Delete combination and
then hold down F2 when prompted. The Setup main menu will appear.

To see the boot options press F7 and choose your preferred boot device.


BIOS Settings 

Warning

Incorrect settings can
cause your system to
malfunction. To correct
mistakes, return to Set-
up and restore the Pre-
vious Values with
<F2>, or Optimized De-
faults with <F3>.

UEFI Boot & POST

When UEFI Boot is en-
abled, then the prompts
to press F2 or F7 will
not appear. However
you can still press F2 to
enter the setup, or F7 to
choose the preferred
boot device, if you press
the key immediately the
system boots up.
5 - 2 The Setup Utility
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Failing the POST
Errors can be detected during the POST. There are two categories, “fatal” and “non-
fatal”.

Fatal Errors
These stop the boot process and usually indicate there is something seriously wrong
with your system. Take the computer to your service representative or authorized
distributor/supplier as soon as possible.

Non-Fatal Errors
This kind of error still allows you to boot. You will get a message identifying the
problem (make a note of this message!) and you can then press F7 (the F7 on screen
will be highlighted to illustrate that the system is processing the request) for boot
options.

Press F2 (give the system a few seconds to enter Setup; the F2 on screen will be
highlighted to illustrate that the system is processing the request) to run the Setup
program and try to correct the problem. If you still get an error message after you
change the setting, or if the “cure” seems even worse, call for help.
The Setup Utility 5 - 3
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Setup Screens
The following pages contain additional advice on portions of the Setup. Along the
top of the screen is a menu bar with menu headings. When you select a heading, a
new screen appears. Scroll through the features listed on each screen to make chang-
es to Setup.

Instructions on how to navigate each screen are in the box at the bottom right side of
the screen.

If these tools are confusing, press F1 to call up a General Help screen, and then use
the arrow keys to scroll up or down the page.

The Item Specific Help on the upper right side of each screen explains the highlight-
ed item and has useful messages about its options.

If you see an arrow  next to an item, press Enter to go to a sub-menu on that sub-
ject. The sub-menu screen that appears has a similar layout, but the Enter key may
execute a command.


Setup Menus

The Setup menus
shown in this section are
for reference only. Your
computer’s menus will
indicate the configura-
tion appropriate for your
model and options.

Figure 5 - 1
Navigation Menu
5 - 4 The Setup Utility
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Main Menu

System Time & Date (Main Menu)
The hour setting uses the 24-hour system (i.e., ØØ = midnight; 13 = 1 pm). If you
can change the date and time settings in your operating system, you will also change
these settings. Some applications may also alter data files to reflect these changes.

Figure 5 - 2
Main Menu
Main Menu 5 - 5
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SATA Port # (Main Menu)
Pressing Enter opens the sub-menu to show the configuration of a optical Device/
HDD on the computer’s SATA Ports.

CPU/System/Extended Memory: (Main Menu)
This item contains information on the CPU type and system memory, and is not user
configurable. The system will auto detect the amount of memory installed.

MB Series / BIOS Revision / KBC/EC firmware Revision
This item contains information on the BIOS version etc., and is not user configu-
rable.
5 - 6 Main Menu
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Advanced Menu

Intel(R) Rapid Start Technology (Advanced Menu)
Enable/disable Intel(R) Rapid Start Technology from this menu. The rapid start
hibernation mode can resume power within 5 to 6 seconds and can remember your
computer's state with zero power. Note that Intel(R) Rapid Start Technology is
not supported in the Windows 10 OS.

Figure 5 - 3
Advanced Menu
Advanced Menu 5 - 7
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Intel(R) Rapid Storage Technology (Advanced Menu)
Enable/disable Intel(R) Rapid Storage Technology from this menu to provide
high-performance SATA RAID capabilities for Windows 8. Note that this menu
item will be available if UEFI Boot is enabled (in the Boot menu) and the SATA
Mode (Advanced Menu) is set to RAID (see below). 

Intel Anti-Theft Technology (Advanced Menu)
Anti-Theft Technology, which is built-in to the processor of the computer, allows
system administrators to render your computer useless to thieves by sending a poi-
son pillencrypted SMS message over a 3G network etc. Administrators can also re-
motely unlock a recovered computer quickly, or direct the system to send location
information (GPS coordinates) back to a central server.

SATA Mode (Advanced Menu)
You can configure SATA (Serial ATA) control to operate in AHCI (Advanced Host
Controller Interface) or RAID (Redundant Array of Independent disks) modes from
this menu. The SATA Mode should be set BEFORE installing an operating sys-
tem, and after you have backed up all necessary files and data (see sidebar).


SATA Mode 

Selection

If you have installed the
Windows operating
system with either AHCI
or RAID mode enabled,
DO NOT disable the set
mode (if you wish to dis-
able the set mode you
will need to reinstall the
Windows OS).
5 - 8 Advanced Menu
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Boot Logo (Advanced Menu)
Use this menu item to enable/disable the Boot Logo screen at system startup if you
have not enabled UEFI Boot. If you disable the Boot Logo you will not see the F2
Enter Setup or F7 Boot Options prompts on the screen, however you can still press
these keys, while the boot screen is displayed, to perform the Enter Setup or Boot
Option functions. 

When UEFI Boot is enabled, then the prompts to press F2 or F7 will not appear.
However you can still press F2 to enter the setup, or F7 to choose the preferred boot
device, if you press the key immediately the system boots up.

Power On Boot Beep (Advanced Menu)
Use this menu item to enable/disable the beep as the computer starts up.

Battery Low Alarm Beep (Advanced Menu)
Use this menu item to enable/disable the battery low alarm beep.
Advanced Menu 5 - 9
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Security Menu

Set Supervisor Password (Security Menu)
You can set a password for access to the Aptio Setup Utility. This will not affect
access to the computer OS (only the Aptio Setup Utility).


Security Menu

The changes you make
here affect the access
to the Setup utility itself,
and also access to your
machine as it boots up
after you turn it on.
These settings do not
affect your machine or
network passwords
which will be set in your
software OS.

Figure 5 - 4
Security Menu
5 - 10 Security Menu
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Note: To clear existing passwords press Enter and type the existing password, then
press Enter for the new password (without typing any password entry) and Enter
again to confirm the password clearance.

Set User Password (Security Menu)
You can set a password for user mode access to the Aptio Setup Utility. This will
not affect access to the computer OS, (only the Setup utility) unless you choose to
set a Password on Boot (see below). Many menu items in the Aptio Setup Utility
cannot be modified in user mode. 

Note: You can only set the user password after you have set the supervisor pass-
word.

Password on boot: (Security Menu)
Specify whether or not a password should be entered to boot the computer (you may
only set a password on boot if a supervisor password is enabled). If “Enabled”
is selected, only users who enter a correct password can boot the system (see the
warning in the sidebar). The default setting is “Disabled”. 


Password Warning

If you set a boot pass-
word (Password on boot
is “Enabled“), NEVER
forget your password. 

The consequences of
this could be serious. If
you cannot remember
your boot password you
must contact your ven-
dor and you may lose all
of the information on
your hard disk.
Security Menu 5 - 11
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Secure Boot Control (Security Menu)
Secure Boot prevents unauthorized operating systems and software from loading
during the startup process. Secure Boot Control is available as a menu option if you
have enabled UEFI Boot (see “TPM Configuration (Security Menu)” on page 5 -
13). Enabling Secure Boot will bring up the Secure Boot Mode menu to enable you
to configure Secure Boot as Standard (with a fixed secure boot policy) or Custom
(which enables you to make changes to the Key Management database).
5 - 12 Security Menu



BIOS Utilities

5

TPM Configuration (Security Menu)
This sub-menu will allow you to enable/disable Trusted Platform Module (TPM)
support, and to configure the TPM State. Select TPM Configuration and press En-
ter to access the sub-menu. Press Enter to access the Security Device Support menu
and select Enable to display the full TPM configuration menu (see “Trusted Plat-
form (Security) Module” on page 6 - 21 for details).

Figure 5 - 5
Security Device 

Support
Security Menu 5 - 13
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TPM State (Security Menu > Security Device Support Enabled)
Select TPM State, press Enter and select Enabled to change the TPM state to en-
abled. You will then need to press F4 to save the changes and restart the computer. 

As the computer restarts press F2 to enter the BIOS again and go to the TPM Con-
figuration menu.

Figure 5 - 6
TPM State (Enabled)
5 - 14 Security Menu
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Pending TPM operation (Security Menu > Security Device Support & TPM State
Enabled)
Select Pending operation, press Enter and select the option you require (if you are
initializing TPM you should select Enable Take Ownership). You will then need
to press F4 to save the changes and restart the computer. You can now install the
TPM driver (see “Trusted Platform Module (TPM) Driver Installation” on page 6
- 24) and then initialize the TPM.

Figure 5 - 7
Pending TPM 

operation 
(Enable Take 
Ownership)
Security Menu 5 - 15
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Boot Menu

When you turn the computer on it will look for an operating system (e.g. Windows
7) from the devices listed in this menu, and in this priority order. If it cannot find
the operating system on that device, it will try to load it from the next device in the
order specified in the Boot Option Priorities.

Figure 5 - 8
Boot Menu


BIOS Screens

Note that the BIOS
screens pictured on
these pages are intend-
ed for guidance in set-
ting up your system’s
BIOS.

BIOS versions are sub-
ject to constant change
and revision, therefore
your computer’s actual
screens may appear
slightly different from
those pictured on these
pages. 
5 - 16 Boot Menu



BIOS Utilities

5

Boot Option Priorities (Boot Menu)
Press Enter to access the menu, use the arrow keys to move up and down the menu,
and press Enter to select a device from the Boot Option # list (the selected device
will be highlighted in white).

UEFI Boot (Boot Menu)
Enable/disable UEFI Boot from this menu. The Unified Extensible Firmware Inter-
face (UEFI) specification provides a clean interface between operating systems and
platform firmware at boot time. In contrast to BIOS, UEFI defines a set of standard
boot and runtime services. The Network Stack item will be enabled as an option un-
der UEFI Boot.
Boot Menu 5 - 17
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Exit Menu

Click Save Changes and Reset to save all changes made. Choosing to Discard
Changes, or Exit Discarding Changes, will wipe out any changes you have made
to the Setup. You can also choose to restore the original Setup defaults that will re-
turn the Setup to its original state, and erase any previous changes you have made in
a previous session.

Figure 5 - 9
Exit Menu
5 - 18 Exit Menu
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Chapter 6: Modules & Options
Overview
This chapter contains information on the following modules, which may come with
your computer, depending on the configuration purchased. If you are unsure please
contact your service representative.

Note that the information included on the following pages is for Windows 8.1 only.
For Windows 10 driver installation see “Windows 10 Drivers & Utilities” on page E
- 15.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see Table 1 - 3,
on page 1 - 12).

• PC Camera Module
• Wireless LAN Module
• Bluetooth & WLAN Combo Module
• Trusted Platform (Security) Module
• Intel® Rapid Storage Technology

• Intel® Smart Response Technology
• Intel® Rapid Start Technology 

Driver
• Wireless Display
Overview 6 - 1
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PC Camera Module
When the PC Camera application is run the LED indicator to the left of the camera
will be illuminated in red (see  Figure 1 - 2 on page 1 - 7). Note that you need to
use the Camera app in Windows 8.1 to take pictures and capture video. Use the Fn
+ F10 key combination (see “Function/Hot Key Indicators” on page 1 - 12) to
toggle power to the PC Camera module.

2

6 - 2 PC Camera Module
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PC Camera Audio Setup
If you want to capture video & audio with your camera, it is necessary to setup the
audio recording options in Windows.

1. Go to the Control Panel.
2. Click Sound  (Hardware and Sound) and click Recording (tab).
3. Right-click hold and release Microphone (Realtek High Definition Audio) and 

make sure the item is not disabled.
4. Double-click Microphone (or select Properties from the right-click menu).
5. Click Levels (tab), and adjust the Microphone and Microphone Boost sliders to 

the level required.
6. Click OK and close the control panels.

Figure 6 - 1
Audio Setup for PC 

Camera

Right-click
PC Camera Module 6 - 3
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Camera App
1. Run the Camera app from the Start screen by clicking on the Camera app icon 

.
2. The camera interface will display two buttons on the right side of the screen.

3. The upper button  is used to record video, and the lower button  is used 
to take still pictures.

4. Right-click on the screen to bring up menu buttons at the bottom of the screen.
5. These buttons enable you to access the camera roll (where captured pictures and 

video are displayed), set the timer (the time period before capture begins; 3 
seconds, 10 seconds or Off) and set the exposure level using the slider to obtain 
the best results.

Figure 6 - 2
Camera App 

Buttons


Exposure

Use the slider to adjust
the Exposure level.

Figure 6 - 3
Camera Options
6 - 4 PC Camera Module
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Camera Options
The Camera Options settings may be accessed as follows:

1. Run the Camera app from the Start screen by clicking on the Camera app icon 
.

2. While the camera app is running access the Charms Bar (e.g. click Use the 
Windows logo key  + D key combination).

3. Click Settings and then click Options.
4. You can adjust the Photo Aspect Ratio, select the Microphone, Hide/Show grid 

lines and turn Location Info on or off from the Options panel.

Figure 6 - 4
Camera Options
PC Camera Module 6 - 5
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Taking Pictures/Capturing Video
1. Run the Camera app from the Start screen by clicking on the Camera app icon 

.
2. Right-click the screen and select the timer if you require a countdown before 

capture.
3. Click the appropriate icon to take a picture or start video capture (if video capture 

begins a timer will appear in the bottom corner of the screen).
4. To stop video capture click the main window again (or click the stop icon ).
5. Captured photos and videos will be saved to a Camera Roll folder within the 

Pictures folder.

Figure 6 - 5
Pictures - Camera 

Roll
6 - 6 PC Camera Module



Modules & Options

6

Camera Roll
1. Run the Camera app from the Start screen by clicking on the Camera app icon 

.
2. Right-click on the screen to bring up menu buttons at the bottom of the screen.
3. Click Camera Roll.
4. Click the arrows  / (on either side of the screen) to browse through the 

captured photos/video, and back to the Camera app.

Editing Photos
1. Clicking on a captured photo will bring up an app bar with a series of buttons.

2. The Camera butt ton will take you back to the home screen of the camera app.
3. Click Delete to remove any photo from the camera roll (you will be asked to click 

Delete again to confirm the deletion).
4. The Open With butt ton will allow you to select a program with which to open the 

photo.
5. You can click Set as Lock screen to set the photo as the lock screen picture.
6. Clicking Slide Show will create a slide show of photos/video in the camera roll.
7. Click Rotate to rotate the picture through 90 degrees.
8. Use the handles to Crop any captured picture, and click Apply to make the 

changes (you can change the Aspect ratio by clicking the button and selecting an 
aspect ratio from the menu). You can Save a copy (create another copy of the 

Figure 6 - 6
Edit Buttons 

(for Still Photos)
PC Camera Module 6 - 7
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photo with the edited changes), Update original (which changes the original 
picture permanently) or Undo any changes.

9. Click the Edit button to bring up a full suite of tools to edit the photo.
10. Click on the menu headings on the left, and then click on the tool on the right to 

edit the photo as required.

11. After the editing process is completed right-click on the photo to Save a copy 
(create another copy of the photo with the edited changes), Update original 
(which changes the original picture permanently), Undo any changes or Cancel 
the editing.

Figure 6 - 7
Editing Tools

Basic Fixes Light Color EffectsEdit Menu
6 - 8 PC Camera Module
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Editing Photos
1. Clicking on a captured video will bring up an app bar with a series of buttons.

2. Click Delete to remove any video from the camera roll (you will be asked to click 
Delete again to confirm the deletion).

3. The Open With butt ton will allow you to select a program with which to run the 
Video.

4. Clicking Slide Show will create a slide show of photos/video in the camera roll.
5. Click Trim to edit the video. Use the round buttons at either end of the slider to 

adjust the video length and click Save a copy to save the changes made.

Figure 6 - 8
Edit Buttons 
(for Video)

Figure 6 - 9
Trim Video 

(for Video Files)
Click to select and move the rounded buttons to edit the video.
PC Camera Module 6 - 9
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Video File Size
Note that capturing high resolution video files requires a substantial amount of disk
space for each file. After recording video, check the video file size (right-click the
file and select Properties) and the remaining free space on your hard disk (go to My
Computer, right-click the hard disk, and select Properties). If necessary you can
remove the recorded video file to a removable medium e.g. CD, DVD or USB Flash
drive.

Note that the Windows 8.1 system requires a minimum of 16GB (32-bit) or 20GB
(64-bit) of free space on the C: drive system partition. In order to prevent system
problems it is recommended that you move any large sized captured video file to a
location other than the C: drive.
6 - 10 PC Camera Module
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Wireless LAN Module
If you have included an Intel® or 3rd Party WLAN module in your purchase option
make sure that the module is on (i.e. the system is not in Airplane Mode) before in-
stalling the driver.

Make sure you install the drivers in the order indicated in Table 4 - 1, on page 4 - 4.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN
& Bluetooth Combo modules.


Wireless Device 

Operation Aboard 
Aircraft

The use of any portable
electronic transmission
devices aboard aircraft
is usually prohibited.
Make sure the WLAN &
Bluetooth module(s)
are OFF if you are using
the computer aboard
aircraft by putting the
system in to Airplane
Mode (see Table 1 - 3,
on page 1 - 12).
Wireless LAN Module 6 - 11
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3rd Party 802.11b/g/n Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in 

Windows (see page 6 - 13).

Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the tickbox to agree to the End User License Agreement and click 

Install.
5. Click Finish.
6. The operating system is the default setting for Wireless LAN control in 

Windows (see page 6 - 13).
6 - 12 Wireless LAN Module
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WLAN Configuration in Windows
You can configure a wireless connection using one of the following options, how-
ever make sure the Wireless LAN module is turned on (and not in Airplane Mode)
before configuration begins.

Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click the WiFi icon (it should read Available under the 

icon and Airplane mode should be Off).
3. A list of available access points will appear.

Figure 6 - 10
WiFi Settings 

(Charms Bar) & 
Networks
Wireless LAN Module 6 - 13
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4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to find other devices or not.
7. When you are connected to the network access point it will display Connected 

.
8. Select any connected network and click Disconnect  to disconnect from a 

connected access point.

9. You can click the Airplane Mode button to turn the mode (including Bluetooth) On 
or Off.

10. Alternatively you can click the  WiFi button to turn just the WiFi On or Off.

Figure 6 - 11
Networks 

Connected / 
Disconnect
6 - 14 Wireless LAN Module
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Desktop Mode
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + 

D key combination).
2. Click the wireless icon  in the notification area of the taskbar.
3. A list of available access points will appear.
4. Double-click an access point to connect to it (or click it and click Connect).
5. Enter a network security key (password) if required, and click Next.
6. You can choose to find other devices or not.
7. Select any connected network and click Disconnect to disconnect from a 

connected access point.

Figure 6 - 12
Windows Desktop 

Taskbar Notification 
Area WLAN 
Connection
Wireless LAN Module 6 - 15
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Bluetooth & WLAN Combo Module
If your purchase option includes the Combination Wireless LAN & Bluetooth
module (either Intel® or 3rd Party) then install the driver as instructed overleaf.

Make sure that the module is on (i.e. the system is not in Airplane Mode) before in-
stalling the driver.


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported
in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.
6 - 16 Bluetooth & WLAN Combo Module
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3rd Party Bluetooth (V4.0) Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. See “Bluetooth Configuration in Windows” on page 6 - 18 for configura-

tion instructions.

Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device 

Drivers & Utilities + User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click in the tickbox to accept the license and click Next.
6. Click Next > Finish.
7. See “Bluetooth Configuration in Windows” on page 6 - 18 for configura-

tion instructions.


High Speed Bluetooth 

Data Transfer

The Combination Wire-
less LAN & Bluetooth
module supports high
speed data transfer. How-
ever to achieve such
transfer speeds, both de-
vices must support
high speed data trans-
fer.

To obtain high speed
data transfer make sure
that both the WLAN and
Bluetooth modules are
powered on.

Check your Bluetooth
compatible device’s doc-
umentation to confirm it
supports high speed data
transfer.
Bluetooth & WLAN Combo Module 6 - 17
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Bluetooth Configuration in Windows
You can configure a Bluetooth connection as below, however make sure the Blue-
tooth module is on (or the system is not in Airplane Mode) before configuration.

Desktop Mode
1. Switch to the Windows Desktop (click the App or use the Windows logo key  + 

D key combination).
2. Click the notification area of the taskbar and double-click the Bluetooth icon  (or

click and select Show Bluetooth Devices).
3. The Bluetooth item in PC and Devices will appear.

OR
Charms Bar
1. Go to the Charms Bar.
2. Select Settings and then click Change PC Settings.
3. Select the Bluetooth item in PC and Devices.


Bluetooth Headset 

Stereo Setup

To setup a Bluetooth
headset to support ste-
reo audio see page 7 -
14.

Figure 6 - 13
Bluetooth Taskbar 
Icon & Change PC 
Settings (Charms 

Bar -Settings)
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4. Make sure that Bluetooth is turned on and a list of discovered devices will appear.
5. Double-click the device you want to pair with the computer and click Pair.

6. On first connection the computer will provide you with a pairing code to be entered 
onto the device.

7. Enter the code into your Bluetooth enabled device and click Yes on the computer 
to complete the pairing.

8. Select a device and click Remove Device to disconnect from any device.

Figure 6 - 14
PC and Devices - 

Bluetooth

Figure 6 - 15
Enter the Passcode
Bluetooth & WLAN Combo Module 6 - 19
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To Make your Computer Discoverable to Bluetooth Devices
1. Switch to the Windows Desktop (click the app or use the Windows logo key  + 

D key combination).
2. Click the notification area of the taskbar, click the Bluetooth icon  and click

Open Settings.
3. Click Options, and make sure that Allow Bluetooth devices to find this 

computer check box (Discovery) has a tick inside it.
4. Make sure that the Alert me when a new Bluetooth device wants to connect 

check box (Connections) has a tick inside it, if you want to be notified when a 
Bluetooth device wants to connect.

Figure 6 - 16
Bluetooth Settings
6 - 20 Bluetooth & WLAN Combo Module
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Trusted Platform (Security) Module
If your purchase option includes the TPM security chip, this allows you to create
and manage digital certificates for user and platform authentication. This type of se-
curity is usually administered within large enterprises and organizations, and there-
fore requires implementation by a system administrator before users can access
security features. 

Individual users can use the TPM as an authentication with the fingerprint reader.

Make sure you have administrator’s rights to your computer, and have a Windows
password enabled for full security protection. In addition Make sure you prepare
a removable media (e.g. a USB flash drive) to store passwords etc. before begin-
ning the TPM initialization process.

Before setting up the TPM functions you must initialize the security platform.
Trusted Platform (Security) Module 6 - 21
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Enabling & Activating TPM
1. Restart the computer.
2. Enter the Aptio Setup Utility pressing F2 during the POST/startup.
3. Use the arrow keys to select the Security menu.
4. Select TPM Configuration and press Enter to access the sub-menu.
5. Press Enter to access the Security Device Support menu and select Enable to 

display the full TPM configuration menu.
6. Select TPM State, press Enter and select Enabled to change the TPM state to 

enabled. You will then need to press F4 to save the changes and restart the 
computer.

7. As the computer restarts press F2 to enter the BIOS again and go to the TPM 
Configuration menu.

Figure 6 - 17
TPM State 
(Enabled)
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8. Select Pending operation, press Enter and select the option you require (if you 
are initializing TPM you should select Enable Take Ownership). You will then 
need to press F4 to save the changes and restart the computer.

9. You can now install the TPM driver (see “Trusted Platform Module (TPM) 
Driver Installation” on page 6 - 24) and then initialize the TPM.

Figure 6 - 18
Pending operation 

(Enable Take 
Ownership)
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Trusted Platform Module (TPM) Driver Installation
1. Make sure you have enabled and activated the TPM in the BIOS before 

installing the driver.
2. Insert the Device Drivers & Utilities + User’s Manual disc into an attached 

DVD drive.
3. Click Option Drivers (button).
4. Click 3.Install TPM Driver > Yes.
5. Click Install > Next.
6. Click the button to accept the license and click Next.
7. Click Next > Next > Install.
8. Click Finish > Yes to restart the computer.
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Initializing TPM
1. Switch to the Desktop app and click the TPM icon right-click the icon  in the 

notification area of the taskbar, and select Security Platform Initialization (or 
click the Security Platform State taskbar bubble).

2. Click User Settings (tab) and click Yes, or right-click the icon  in the 
notification area of the taskbar, and select Security Platform Initialization (or 
click the Security Platform State taskbar bubble).

3. The Quick Initialization method will automatically be selected for you (if you need 
to use advanced settings provided by your network administrator then select 
Advanced Initialization).

4. You will need to use a removable media (e.g. a USB Flash Drive) to store 
passwords and data (keep the media in a safe place until required).

5. Select the drive you want to use from the drop-down menu and click Next.

Figure 6 - 19
Security Platform 

Quick Initialization 
Wizard
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6. Choose the Security Platform Features you want to use by clicking the 
appropriate tickbox.

7. Enter a Basic User Password (and re-type to confirm it) and click Next.

8. Click Next to confirm the settings.
9. The computer will then initialize the settings.
10. Click Finish.
11. Click the tabs and control panels to adjust the settings.
12. Double-click the icon  in the taskbar notification area to access the Infineon 

Security Platform Settings Tool, or right-click the icon  and select a menu 
item.


Help

Right-click the icon  in
the notification area of the
taskbar to bring up the menu
to select Help or How to use
the Security Platform Fea-
tures.

You can also click the Help
button in any of the Infineon
Security Platform Settings
Tool tabs to bring up specific
help topics on each tab.

Figure 6 - 20
Settings
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Infineon Security Platform Settings Tool
The Infineon Security Platform Settings Tool allows you to manage and check the
TPM state, manage your password information, and to backup and restore the TPM
data. As TPM is usually administered within large enterprises and organizations,
your system administrator will need to assist you in managing the information here.


Menus

Note that not all the
menus pictured here will
be available for access.
The menu items that ap-
pear will be dependent on
your configuration set-
tings etc. (see the Help
file for full details). 

Figure 6 - 21
Infineon Security 
Platform Settings 

Tool
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User Settings
This page allows the settings to be configured for the currently logged in Infineon
Security Platform user including the ability to change the password, configure se-
cure e-mail, file and folder encryption and Enhanced Authentication. You can also
import or delete certificates protected by the security platform.

Figure 6 - 22
Infineon Security 
Platform Settings 

Tool (User Settings)
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Backup
Here you can configure backup and restore operations. Backup files contain the
computer identification and user identification information which is used to match
the machine name and user name with the current machine and user during restora-
tion.

Figure 6 - 23
Infineon Security 
Platform Settings 

Tool (Backup)
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Migration
The Migration tab is used to help securely transfer keys and certificates from one
platform to another.

Figure 6 - 24
Infineon Security 
Platform Settings 
Tool (Migration)
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Password Reset
Use Password Reset to reset basic user passwords when required.

Figure 6 - 25
Infineon Security 
Platform Settings 

Tool 
(Password Reset)
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BitLocker
BitLocker Drive Encryption can be used in conjunction with the TPM to encrypt
data on the disk and is done via the Microsoft BitLocker Control Panel Applet.
Click Configure and select a drive to be encrypted and then follow the Wizard to
begin the encryption process.

Figure 6 - 26
Infineon Security 
Platform Settings 

Tool 
(BitLocker)
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Access the Microsoft BitLocker Drive Encryption control panel applet from the
Windows control panel (System and Security).

Figure 6 - 27
BitLocker Drive 

Encryption
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Advanced
Configure all the Security Platform owner and policy settings from the Advanced
tab. The settings that can be changed are for the local computer only.

Figure 6 - 28
Infineon Security 
Platform Settings 

Tool 
(Advanced)
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Intel® Rapid Storage Technology
Install the Intel® Rapid Storage Technology to support your AHCI or RAID mode
SATA drive (see “SATA Mode (Advanced Menu)” on page 5 - 8).

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the DVD 

drive.
2. Click Option Drivers (button).
3. Click 4.Install IRST Driver > Yes.
4. Click Next.
5. Click in the tickbox to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.
8. Run the Intel® Rapid Storage Technology app from the Start screen.
Intel® Rapid Storage Technology 6 - 35



Modules & Options

6

Intel® Smart Response Technology
Intel® Smart Response Technology is an Intel® Rapid Storage Technology
(RST) caching feature that accelerates computer system performance by using the
SSD as cache memory between the hard disk drive and system memory.

System Requirements to support Intel® Smart Response Technology:
• System BIOS with SATA mode set to RAID (see ““SATA Mode (Advanced 

Menu)” on page 5 - 8).
• Intel Rapid Storage Technology software installed. 
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB (or with a parti-

tion on the drive formatted to more than 18.6GB e.g a 20GB partition set on the 
SSD). Note that the SSD requires at least 5MB of free unpartitioned and unallo-
cated space (if you have used all the disk space for the partition you will need to 
shrink some of space for the cache memory’s use).

See overleaf for instructions on enabling Intel® Smart Response Technology.

Figure 6 - 29
Computer 

Management - Disk 
Management - 

Unallocated SSD 
Space 
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Enabling Intel Smart Response Technology
1. Run the Intel® Rapid Storage Technology application.
2. Click Enable acceleration under Performance > Smart Response Technology 

(note that you will at least 5MB of free unpartitioned and unallocated space on the SSD 
otherwise the Smart Response Technology item will not appear).

3. Select the SSD to be used as a cache device.
4. Select the size from the SSD to be allocated for the cache memory (any remaining 

space on the SSD can be used for data storage using the simple data single-disk 
RAID 0 volume that is automatically created).

Figure 6 - 30
Intel® Rapid 

Storage 
Technology - 
Performance 

Enable 
Acceleration
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5. Select the HDD (or RAID volume) to be accelerated (it is highly recommended that 
you accelerate the system volume or system disk for maximum performance).

6. Select the acceleration mode, and then click OK (Enhanced mode is selected by 
default).

Note: Enhanced mode (default): Acceleration optimized for data protection.
Maximized mode: Acceleration optimized for input/output performance.

Figure 6 - 31
Enable 

Acceleration 
Options
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7. The page will refresh and report the new configuration in under Performance > 
Smart Response Technology.

Figure 6 - 32
Intel® Rapid 

Storage 
Technology - 
Performance 

(Smart Response 
Technology)
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Intel® Rapid Start Technology Driver
Intel(R) Rapid Start Technology can resume power from Hibernation within 5 to
6 seconds and can remember your computer's previous state with zero power.

System Requirements to support Intel® Rapid Start Technology:
• Rapid Start Technology should be enabled in the BIOS (see ““Intel(R) Rapid 

Start Technology (Advanced Menu)” on page 5 - 7).
• Intel Rapid Storage Technology software installed. 
• A Solid State Drive (SSD) with a minimum capacity of 18.6GB.
• The Solid State Drive (not the  HDD) must be configured as outlined on the fol-

lowing pages to support Rapid Start Technology.
• The Windows operating system must be installed on the system hard disk drive, 

and not on the Solid State Drive (SSD).

See overleaf for instructions on enabling Intel® Rapid Start Technology.


Operating System Installation

Note that in order for Intel(R) Rapid Start Technology to function properly the Windows
operating system must be installed on the system hard disk drive (e.g. the “C:” drive), and
the SSD should be configured as outlined on the following pages. Rapid Start will not func-
tion if the operating system is installed on the SSD.
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Intel® Rapid Start Technology Configuration
1. Enable/disable Intel(R) Rapid Start Technology from the BIOS (see “Intel(R) 

Rapid Start Technology (Advanced Menu)” on page 5 - 7).
2. Go the Windows control panel and double-click Administrative Tools (System 

and Security)> Computer Management > Storage > Disk Management
3. Right-click the SSD and select Shrink Volume from the menu.

Figure 6 - 33
Computer 

Management 
(Shrink SSD 

Volume)

Shrink Volume
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4. Enter the figure, which should be equal to amount of system memory (RAM) 
in your computer, in “Enter the amount of space to shrink in MB”.

5. Click Shrink (any unallocated file space may be formatted for storage use).

Figure 6 - 34
Shrink Volume 

Size


Memory Size (Amount of Space to Shrink)

The figure entered in the “Enter the amount of space to shrink in MB” field above should be equal
to the amount of system memory in your computer. In the example above the system memory is 4GB
(1024MB * 4 = 4096GB). If you are unsure of your total system memory (RAM) then go to System
control panel (System and Security) and check Installed memory (RAM). The memory size will be dis-
played in GB so convert by multiplying the GB figure by 1024 to get the total in MB (e.g. 8GB =
8192MB).
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6. Run the Desktop app and right-click the lower left hot corner (or use the Windows 
Logo Key  + X key combination) and select Command Prompt (Admin).

7. Type “DISKPART”.
8. At the DISKPART command type “list disk”.

Figure 6 - 35
Search for CMD 

Prompt

Figure 6 - 36
Diskpart - List Disk
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9. Type “select disk #” (# is disk number where you want to create the store 
partition, so refer to the results obtained from "list disk" for exact disk number).

10. The message “Disk # is now the selected disk.” will appear.

11. Type “create partition primary”.
12. A “DiskPart succeeded in creating the specified partition.” message should 

appear.

Figure 6 - 37
Diskpart - Select 

Disk #

Figure 6 - 38
Diskpart - Create 

Partition
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13. Type “detail disk”.

14. Type “select Volume #” (# is volume of your storage partition so refer to results 
obtained from "detail disk" for the exact volume number).

15. The message “Volume # is now the selected volume.” will appear.

Figure 6 - 39
Diskpart - Detail 

Disk

Figure 6 - 40
Diskpart - Select 

Volume #
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16. Type the following, depending on the format of the SSD.

• For MBR formatted SSDs: “set id=84 override” (the id must be set to 84).
• For GPT formatted SSDs: “set id=D3BFE2DE-3DAF-11DF-BA40-E3A556D89593”.

17. The message “DiskPart successfully set the partition ID.” will appear.
18. Close the CMD window.

Figure 6 - 41
Diskpart - Set id=
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19. Go the Windows control panel and double-click Administrative Tools (System 
and Security)> Computer Management > Storage > Disk Management.

20. The disk partition should read Healthy Hibernation Partition.

21. Restart the computer.
22. Install the driver (see below).

Intel® Rapid Start Technology Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into the CD/

DVD drive.
2. Click Option Drivers (button).
3. Click 5.Install Rapid Start Driver > Yes.
4. Click Next > Next > Yes > Next > Next.
5. Click Finish to restart the computer.

Figure 6 - 42
Computer 

Management 
(Healthy 

Hibernation 
Partition)Healthy (Hibernation Partition)
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Wireless Display
Wireless Display uses your Wireless LAN module/WLAN Bluetooth Combo mod-
ule (you need to make sure that your video adapter/display device is compatible with
your particular WLAN/Combo module) in conjunction with a compatible video
adapter/display device (purchased separately) to allow you to display the contents of
the notebook display on another display (e.g. HDTV), without the need to have ca-
bles stretching across a room.

You can use the wireless display to play games, browse the internet, display videos
or photo slide shows on your TV/external display without using HDMI or A/V ca-
bles.

Before configuring Wireless Display you will need to set up your compatible
adapter with your display/speakers. Connect the adapter using an HDMI or A/V ca-
ble and turn on the display (or in the case of speakers connect them to the wireless
speaker adapter with the cables provided with the adapter), and then set the display
to the appropriate input channel (see the documentation supplied with your compat-
ible adapter/display for full details).

Note that no driver or application is required for wireless display in Windows 8.1.


Compatible 
Adapters

For a list of compatible
display and audio adapt-
ers check the Intel web-
site, or your distributor/
supplier.
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Wireless Display Configuration
1. Note that no driver or application is required for wireless display in Windows 8.1.
2. Go the Charms Bar, select Devices.
3. Click Project.
4. Click Add a wireless display.

Figure 6 - 43
Add a Wireless 

Display
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5. The system will then search for compatible display devices (this may take up to
60 seconds so allow time for this to complete).

6. Double-click any detected display device in the list.
7. You may then need to input a pin number for the device to which you are 

connecting.
8. Click Next.

Figure 6 - 44
Searching For 

Devices

Figure 6 - 45
Enter PIN
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9. The display will then connect (for specific settings for your display see the 
documentation supplied with your compatible adapter/display for full details).

10. To disconnect from the display you can select it in PC and Devices > Devices and 
click Remove Device > Yes; or go to the Project menu (Charms Bar > Devices) 
and click Disconnect.

Figure 6 - 46
Remove Device/

Disconnect
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Chapter 7: Troubleshooting

Overview
Should you have any problems with your computer, before consulting your service representative, you may want
to try to solve the problem yourself. This chapter lists some common problems and their possible solutions. This
can’t anticipate every problem, but you should check here before you panic. If you don’t find the answer in these
pages, make sure you have followed the instructions carefully and observed the safety precautions in the preface.
If all else fails, talk to your service representative. You should also make a record of what happened and what
remedies you tried.

Of course, if something goes wrong, it will happen at the most inconvenient time possible, so you should preview
this section just in case. If, after you’ve tried everything, and the system still won’t cooperate, try turning it off
for a few minutes and then rebooting. You will lose any unsaved data, but it may start working again. Then call
your service representative.
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Basic Hints and Tips
Many of the following may seem obvious but they are often the solution to a problem when your computer ap-
pears not to be working. 

• Power - Is the computer actually plugged into a working electrical outlet? If plugged into a power strip, 
make sure it is actually working. Check the LED Power & Communication Indicators (see “LED Indica-
tors” on page 1 - 9) to see the computer’s power status.

• Connections - Check all the cables to make sure that there are no loose connections anywhere.

• Power Savings - Make sure that the system is not in Hibernate or Sleep mode by pressing the keys config-
ured in your Power Options (see “Power-Saving States” on page 3 - 7), the Fn + F4 key combination, or 
power button to wake-up the system.

• Brightness - Check the brightness of the screen by pressing the Fn + F8 and F9 keys to adjust the bright-
ness.

• Display Choice - Press Fn + F7 to make sure the system is not set to “external only” display.

• Boot Drive - Make sure there are no optical media and/or USB storage devices in any connected drive 
(this is a common cause of the message “Invalid system disk - Replace the disk, and then press any key” / 
“Remove disks or other media. Press any key to restart”).
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Backup and General Maintenance
• Always backup your important data, and keep copies of your OS and programs safe, but close to hand. 

Don’t forget to note the serial numbers if you are storing them out of their original cases, e.g. in a CD wal-
let.

• Run maintenance programs on your hard disk and OS as often as you can. You may schedule these pro-
grams to run at times when you are not using your computer. You can use those that are provided free with 
your OS, or buy the more powerful dedicated programs to do so.

• Write down your passwords and keep them safe (away from your computer). This is especially important if 
you choose to use a Supervisor password for the BIOS (see “The Setup Utility” on page 5 - 2).

• Keep copies of vital settings files such as network, dialup settings, mail settings etc.(even if just brief notes).


Warranty

The CPU is not a user serviceable part. Opening this compartment, or accessing the CPU in any way, may violate your war-
ranty.
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Viruses
• Install an Anti-Virus program and keep the definitions file (the file which tells your program which viruses 

to look for) up to date. New computer viruses are discovered daily, and some of them may seriously harm 
your computer and cause you to lose data. Anti-Virus programs are commercially available and the defini-
tions file updates are usually downloadable directly from the internet.

• Be careful when opening e-mail from sources you don’t know. Viruses are often triggered from within e-
mail attachments so take care when opening any attached file. You can configure most Anti-Virus pro-
grams to check all e-mail attachments. Note: You should also beware of files from people you know as the 
virus may have infected an address book and been automatically forwarded without the person’s knowl-
edge.

• Keep a “Bootable CD-ROM/DVD-ROM/USB storage device” (this CD/DVD/USB device provides basic 
information which allows you to startup your computer) handy. You may refer to your OS’s documentation 
for instructions on how to make one, and many Anti-Virus programs will also provide such a disk (or at 
least instructions on how to make one).
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Upgrading and Adding New Hardware/Software
• Do not be tempted to make changes to your Windows Registry unless you are very sure of what you are 

doing, otherwise you will risk severely damaging your system.

• Don’t open your computer or undertake any repair or upgrade work if you are not comfortable with what 
you are doing.

• Read the documentation. We can assume, since you are reading this that you are looking at the computer’s 
manual, but what about any new peripheral devices you have just purchased? Many problems are caused by 
the installation of new hardware and/or software. Always refer to the documentation of any new hardware 
and/or software, and pay particular attention to files entitled “READ ME” or “READ ME FIRST”.

• When installing a new device always make sure the device is powered on, and in many cases you will need 
to restart the computer. Always check that all the cables are correctly connected.

• Make sure you have installed the drivers for any new hardware you have installed (latest driver files are 
usually available to download from vendor’s websites).
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• Thoroughly check any recent changes you made to your system as these changes may affect one or more 
system components, or software programs. If possible, go back and undo the change you just made and see 
if the problem still occurs.

• Don’t over complicate things. The less you have to deal with then the easier the source of the problem may 
be found; Example - if your computer has many devices plugged into its ports, and a number of programs 
running, then it will be difficult to determine the cause of a problem. Try disconnecting all of the devices 
and restarting the computer with all the peripheral devices unplugged. A process of elimination (adding and 
removing devices and restarting where necessary) will often find the source of a problem, although this may 
be time consuming.
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Problems and Possible Solutions

Problem Possible Cause - Solution

You turned on the power but it doesn’t
work.

Battery missing / incorrectly installed. Check the battery bay, make sure the
battery is present and seated properly (the design of the battery only allows it to
go in one way). Make sure there’s nothing interfering with the battery contacts.

The battery LED power indicator , is
blinking orange.

Low Battery. Plug in the DC power source. If the computer doesn’t start up
immediately, turn it off then on again.

You are losing battery power too quickly. The system is using too much power. If your OS has a Power Options scheme
(see “Power Plans” on page 3 - 5) check its settings. You may also be using a
peripheral device/USB device that is drawing a lot of power.

Actual battery operating time is shorter
than expected.

The battery has not been fully discharged before being recharged. Make sure
the battery is fully discharged and recharge it completely before reusing (see
“Battery Information” on page 3 - 14).

Power Options have been disabled. Go to the Control Panel in Windows and
re-enable the options.

A peripheral device/USB device is consuming a lot of power. Turn off/remove
the unused device to save power.
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The computer feels too hot. Make sure the computer is properly ventilated and the Vent/Fan intakes are not
blocked. If this doesn’t cool it down, put the system into Hibernate mode or turn
it off for an hour. Make sure the computer isn’t sitting on a thermal surface (see
“Overheating” on page 1 - 15/1 - 16). Make sure you’re using the correct
adapter. 

Make sure that your notebook is completely powered off before putting it into a
travel bag (or any such container). Putting a notebook which is powered on in a
travel bag may cause the Vent/Fan intakes to be blocked.

Nothing appears on screen. The system is in a power saving mode. Toggle the sleep/resume key
combination, Fn + F4 (see “Configuring the Power Buttons” on page 3 - 9).

The screen controls need to be adjusted. Toggle the screen control key
combinations Fn + F8/F9. If you’re connected to an external monitor, make sure
it’s plugged in and turned on. You should also check the monitor’s own
brightness and contrast controls.

The computer is set for a different display. Toggle the screen display key
combination, Fn + F7. If an external monitor is connected, turn it on.

The screen saver is activated. Press any key or touch the TouchPad.

No image appears on the external
monitor I have plugged in and powered
on.

You haven’t installed the video driver and configured it appropriately from the
Control Panel. See Appendix C for instructions on installing and configuring
the video driver.

Problem Possible Cause - Solution
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You forget the boot password. If you forget the password, you may have to discharge the battery of the CMOS.
Contact your service representative for help.

The sound cannot be heard or the volume
is very low.

The volume might be set too low. Check the volume control in the Volume
Control Panel in the Windows notification area, or use the key combination Fn
+ F5 and F6 (see “Function/Hot Key Indicators” on page 1 - 12) to adjust.

Unwelcome numbers appear when
typing.

Num Lock is turned ON (see “Function/Hot Key Indicators” on page 1 - 12).

I am sliding my finger up and down on the
right side of the Touchpad to scroll a
Window and the Touchpad does not
respond.

There are different Touchpad versions available on this computer, and this
version requires tapping/holding to scroll. Either tap repeatedly, or hold the
finger down, at the top or bottom right of the Touchpad (depending on the
scrolling direction required) to scroll the window.

Problem Possible Cause - Solution


Password Warning

If you choose to set a boot password, NEVER forget your password. The consequences of this could be serious. If you cannot
remember your boot password you must contact your vendor and you may lose all of the information on your hard disk.
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The system freezes or the screen goes
dark.

The system’s power saving features have timed-out. Use the AC/DC adapter,
press the sleep (Fn + F4) key combination, or press the power button if no LEDs
are lit.

The system never goes into a power
saving mode.

Power Options features are not enabled. Go to the Windows Power Options
menu and enable the features you prefer (see “Power-Saving States” on
page 3 - 7). Make sure you have enabled Hibernate mode from the control
panel.

The computer is off (or in Sleep Mode) but
powered by the AC/DC adapter plugged in
to a working outlet, or by battery with a
capacity above 20%. I have plugged a
device into the powered USB port in
order to charge it, but the device is not
charging.

The port is not powered on. Toggle power to the port using the Fn + power
button combination.

This function may not work with certain external USB compliant devices (check
your device’s documentation). If this is the case, power the computer on and
connect the external USB device in order to charge it.

Note that this function is designed to help charge USB compliant devices, but
is not designed to allow their operation.

Problem Possible Cause - Solution


Other Keyboards

If your keyboard is damaged or you just want to make a change, you can use any standard USB keyboard. The system will
detect and enable it automatically. However special functions/hot keys unique to the system’s regular keyboard may not
work.
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The Wireless LAN/Bluetooth modules
cannot be detected.

The modules are off as the computer is in Airplane Mode. Check the LED
indicator  to see if it is in Airplane Mode (see “LED Indicators” on page 1 -
9). Use the Fn + F11 key combination to toggle Airplane Mode on/off (see
Table 1 - 3, on page 1 - 12).

The PC Camera module cannot be
detected.

The module is off. Press the Fn + F10 key combination in order to enable the
module (see “Function/Hot Key Indicators” on page 1 - 12). Run the camera
application to view the camera picture.

The Wireless LAN/Bluetooth modules
cannot be configured.

The driver(s) for the module(s) have not been installed. Make sure you have
installed the driver for the appropriate module (see the instructions for the
appropriate module in Chapter 6 "Modules & Options").

A file cannot be copied to/from a
connected Bluetooth device.

The transfer of data between the computer and a Bluetooth enabled device is
supported in one direction only (simultaneous data transfer is not
supported). If you are copying a file from your computer to a Bluetooth enabled
device, you will not be able to copy a file from the Bluetooth enabled device to
your computer until the file transfer process has been completed

I cannot obtain high speed Bluetooth data
transfer.

To obtain high speed Bluetooth data transfer take into account the following:

• To achieve high speed transfer speeds, both devices must support high 
speed data transfer (i.e both the computer and the Bluetooth compati-
ble device you are connecting to).

• Check your Bluetooth compatible device’s documentation to confirm it 
supports high speed data transfer, and for configuration information.

Problem Possible Cause - Solution
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I have used Update Driver in Device
Manager (Unknown device > Other
Devices) to try and install the Airplane
Mode driver. Windows encountered a
problem in attempting to update the driver,
and a yellow exclamation mark appears
in Device Manager against the Unknown
device.

It is very important that the drivers are installed in the order indicated in Chapter
4 (which is the numbered installation order on the Device Drivers & Utilities +
User’s Manual disc). This issue can occur when drivers are manually installed,
and not in the correct order.

If you have attempted to Update Driver from the Device Manager control panel
and have encountered problems, then use the method below to correct this:

To correct this problem:

1. Go to the Programs and Features (Programs) control panel in 
Windows.

2. Select any installed Airplane Mode driver item (e.g. Insyde Airplane 
Mode HID Mini-Driver), and click Uninstall/Change to uninstall the 
current driver.

3. Restart the computer.
4. Insert the Device Drivers & Utilities + User’s Manual disc and click 

Install Drivers (button).
5. Double-click the Airplane AP item in the menu.
6. Follow the instructions to install the correct driver (you will need to 

restart the computer as part of the installation process).

Problem Possible Cause - Solution
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I have connected a Bluetooth mouse but
it loses the Bluetooth connection and
no longer responds after a short period of
inactivity.

This is an issue with this mouse type and the Intel Wireless 7260 WLAN and
Bluetooth combo module series. To resolve this issue do the following:

1. Go to the Device Manager control panel in Windows.
2. Click the arrow alongside Bluetooth to expand the menu if required.
3. Double-click Intel(R) Wireless Bluetooth(R) 4.0 + HS Adapter.
4. Click the Power Management tab.
5. Make sure that the tickbox alongside “allow the computer to turn 

off this device to save power” doesn’t have a tick alongside it.
6. Click OK and close the control panel.

Figure 7 - 1 - Device Manager (Bluetooth)

Problem Possible Cause - Solution
Problems and Possible Solutions 7 - 13
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When using a Bluetooth headset the
audio appears to be mono and not
stereo.

This is a common issue with Bluetooth headsets. To resolve this issue do the
following (you will need to repeat this procedure after every boot up, restart,
or when the system resumes from hibernation):

1. Go to the Devices & Printers control panel in Windows.
2. Double-click the Bluetooth headset.
3. Click Connect to complete the stereo connection.
OR
1. Go to the Sound control panel in Windows.
2. Right-click (in the Playback tab) the Bluetooth Stereo Audio device 

(the default device is Headset).
3. Click Connect to complete the stereo connection.

Problem Possible Cause - Solution
7 - 14 Problems and Possible Solutions
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Appendix A: Interface (Ports & Jacks)

Overview
The following chapter will give a quick description of the interface (ports & jacks) which allow your computer
to communicate with external devices, connect to the internet etc.
Interface (Ports & Jacks) A - 1
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Notebook Ports and Jacks

Item Description

Card Reader Port The card reader allows you to use some of the latest digital storage cards. Push the card into the
slot and it will appear as a removable device.

DC-In Jack Plug the supplied AC/DC adapter into this jack to power your computer.

HDMI-Out Port The HDMI-Out (High-Definition Multimedia Interface) is an audio/video connector interface for
transmitting uncompressed digital streams. This allows you to connect an external monitor, TV or
Flat Panel Display etc. as a display device by means of a HDMI cable. Note that HDMI carries
both audio and video signals.

Headphone-Out Jack Headphones or speakers may be connected through this jack. Note: Set your system’s volume to
a reduced level before connecting to this jack.

Microphone-In Jack Plug an external microphone in to this jack to record on your computer.

Mini DisplayPort The Mini DisplayPort is a miniatuarized version of the DisplayPort, which is a digital display
interface standard that allows a digital audio/video interconnect, between the computer and its
external display or a home-theater system.
A - 2 Interface (Ports & Jacks)
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RJ-45 LAN Jack This port supports LAN (Network) functions.
Note: Broadband (e.g. ADSL) modems usually connect to the LAN port.

Security Lock Slot To prevent possible theft, a Kensington-type lock can be attached to this slot. Locks can be
purchased at any computer store.

USB 3.0 Ports

Powered USB 3.0 Port

These USB 3.0 compatible ports (backwards-compatible with USB 2.0 however USB 3.0 will
transfer data much faster than USB 2.0) are for low-speed peripherals such as keyboards, mice
or scanners, and for high-speed peripherals such as external HDDs, digital video cameras or
high-speed scanners etc. Devices can be plugged into the computer, and unplugged from the
computer, without the need to turn the system off (if the power rating of your USB device is
500mA or above, make sure you use the power supply which comes with the device).

Note: The powered USB 3.0 port (see “Right & Rear Views” on page 1 - 15) may be toggled
on /off by means of the Fn + Power Button key combination (press for around 1 to 2 seconds
to toggle). When the powered USB port is on it will supply power (for charging devices only, not
for operating devices) when the system is off but still powered by the AC/DC adapter plugged
into a working outlet, or powered by the battery with a capacity level above 20% (this may not work
with certain devices - see page 7 - 10).

Note: This function is designed to help charge USB compliant devices, but is not designed to
allow their operation.

Item Description

3.0

3.0
Interface (Ports & Jacks) A - 3
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Appendix B: Control Center
Overview
The following chapter will give a quick description of the functions of the Control Center. The Control Center
gives quick access to frequently used controls, power management features and enables you to quickly turn mod-
ules on/off. Click the Control Center icons to toggle the appropriate function, or hold the mouse button down
and move the slider where applicable. Certain functions will automatically be adjusted when a power mode is
selected. The Control Center in Windows 8.1 works under the Desktop app and not under the Start screen.

Figure B - 1 - Control Center
Control Center B - 1
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Power Modes 
You can set a Power Mode by clicking the appropriate icon at the top of the Control Center. Each power
mode will affect screen brightness, Touchpad and PC camera power etc.

You can click a Control Center icon to set an overall power mode and then click individual icons in the
Control Center to power on/off the Touchpad and PC camera.

Table B - 1- Power Modes

Modes Power Saving Entertainment Quiet Performance
User 

Defined

Icon

Power Plan Power Saver Power Saving Power Saving
High 

Performance

U
se

r D
e

fined

Power Conservation 
Mode

Energy Star Energy Star Energy Star Performance

Brightness 10 100 40 100

PC Camera OFF OFF ON ON

TouchPad ON ON ON ON
B - 2 Control Center
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Power Status
The Power Status icon will show whether you are currently powered by the battery, or by the AC/DC adapter
plugged in to a working power outlet. The power status bar will show the current battery charge state.

Brightness
The Brightness icon will show the current screen brightness level. You can use the slider to adjust the screen
brightness or the Fn + F8/F9 key combinations, or use the Fn+ F2 key combination to turn off the LED backlight
(press any key to turn it on again). Note that screen brightness is also effected by the Power Mode selected (see
Table B - 1, on page B - 2).

Volume
The Volume icon will show the current volume level. You can use the slider to adjust the Volume or the Fn +
F5/F6 key combinations, or use the Fn+ F3 key combination to mute the volume.

Power Conservation
This system supports Energy Star power management features that place computers (CPU, hard drive, etc.) into
a low-power sleep modes after a designated period of inactivity (see “Power Conservation Modes” on page 3 -
12). Click either the Performance, Balanced or Energy Star button.
Control Center B - 3
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Sleep 
Click the Sleep button to bring up the Hibernate  or Sleep  buttons, and click either button to have the
computer enter the appropriate power-saving mode (see “Power-Saving States” on page 3 - 7).

Display Switch 
Click the Display Switch button to access the menu (or use the  + P key combination) and select the appro-
priate attached display mode (see page C - 18).

Time Zone 
Clicking the Time Zone button will access the Date and Time Windows control panel.

Desktop Background 
Clicking the Desktop Background button will allow you to change the desktop background picture.

TouchPad/PC Camera 
Click either of these buttons to toggle the TouchPad or camera module’s power status. A crossed out icon will
appear over the top left of the icon  when it is off. Note that the power status of the camera module is also
effected by the Power Mode selected (see Table B - 1, on page B - 2).

Caps Lock/Scroll Lock/ Number Lock 
Click the button to toggle the appropriate lock mode.
B - 4 Control Center



Video Driver Controls

C

Appendix C: Video Driver Controls
The basic settings for configuring the LCD are outlined in “Video Features” on
page 1 - 28. Make sure you install the drivers in the order indicated in Table 4 - 1,
on page 4 - 4.

Video (VGA)
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached 

DVD drive.
2. Click 2.Install VGA Driver > Yes.
3. Click Next > Yes > Next > Next.
4. Click Finish to restart the computer.

Dynamic Video Memory Technology
Intel® DVMT automatically and dynamically allocates as much (up to 1748MB)
system memory (RAM) as needed to the integrated video system (the video driver
must be installed). DVMT returns whatever memory is no longer needed to the op-
erating system.


Video Card Options

Note that card types,
specifications and driv-
ers are subject to contin-
ual updates and
changes. Check with
your distributor/supplier
for the latest details on
video cards supported.

DVMT Notes

DVMT is not local video
memory.

DVMT will not function
in MS-DOS. DOS uses
the legacy memory indi-
cated.
Dynamic Video Memory Technology C - 1
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Intel® HD Graphics Control Panel
Advanced video configuration options are provided by the Intel® HD Control Pan-
el. To access the control panel see below and overleaf:

1. Click the Intel® HD Graphics Control Panel icon in the Start screen.

(see over)

Figure C - 1
Start Screen

Intel® HD Graphics 

Control Panel
C - 2 Intel® HD Graphics Control Panel
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OR
2. Right-click the Desktop and select Graphics Properties from the menu.
OR
3. Click Advanced settings in the Screen Resolution control panel in Windows.
4. Click the Intel(R) HD Graphics Control Panel tab and click Graphics Properties

(button).
5. Double-click the Intel(R) HD Graphics control panel in the Windows Control

Panel. 

Figure C - 2
Intel® HD Graphics 

Control Panel
Intel® HD Graphics Control Panel C - 3
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You may make changes to any of the graphics properties by clicking the appropriate
menu panel and adjusting the settings on the right.

Figure C - 3
Intel® HD Graphics 

Control Panel
C - 4 Intel® HD Graphics Control Panel
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Sub-Menus
Some of the menu panels will also have sub-menus (in the top left corner of the menu
alongside the icon ) to display further configuration options.

Figure C - 4
Intel® HD Graphics 

Control Panel

Sub-Menus
Intel® HD Graphics Control Panel C - 5
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Display
Click either Display Settings or Color to make display adjustments, including con-
figuration for any attached external displays.


Multiple Display 

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Figure C - 5
Intel® HD Graphics 

Control Panel 

Display Settings
C - 6 Intel® HD Graphics Control Panel
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Click the Display menu at the top of the screen to display the sub-menus. The Mul-
tiple Displays menu allows you to configure the display mode of any attached dis-
plays (see “Attaching Other Displays” on page C - 16).


Multiple Display 

At least one other dis-
play must be attached in
order to view multiple
display selection op-
tions.

Figure C - 6
Intel® HD Graphics 

Control Panel 

Display Settings - 

Multiple Displays
Intel® HD Graphics Control Panel C - 7
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The Audio sub-menu allows you to configure the capability mode of any attached
displays if applicable (i.e. the attached display supports audio). Enable Audio
Without Video to keep audio on when the display blanks out for power saving pur-
poses.

Figure C - 7
Intel® HD Graphics 

Control Panel 

Display Settings - 

Audio
C - 8 Intel® HD Graphics Control Panel
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3D
This menu allows you to choose how 3D images are displayed. Quality displays the
most detail, Balanced provides better computer performance with good quality and
Custom allows you to configure the Anisotropic Filtering, Vertical Sync and
Anti-Aliasing features to your preferences. Click Apply to save changes.

Figure C - 8
Intel® HD Graphics 

Control Panel 3D
Intel® HD Graphics Control Panel C - 9
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Options
Options allows you to Customize Hot Keys (for opening the application, rotating
the display, scaling etc.,) to your preferences. Click Apply to save changes.

Figure C - 9
Intel® HD Graphics 

Control Panel 

Options
C - 10 Intel® HD Graphics Control Panel
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Click the Options menu at the top of the screen to display the sub-menus. The In-
formation Center provides details on System Information, the Built-In Display
and any attached displays.


Preferences 

Go to the Preferences
sub-menu in Options to
configure the preferenc-
es for the Intel® HD
Graphics Control Panel.

Make sure you turn Tray
Icon On to display the
Intel® HD Graphics
Control Panel icon in the
notification area of the
taskbar (as below).

Figure C - 10
Intel® HD Graphics 

Control Panel 

Options - 

Information Center
Intel® HD Graphics Control Panel C - 11
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Video
The Video Profiles menu allows you to brighten or darken movies, or to switch to
vivid colors. Click Basic or Advanced to adjust the video settings based on the Ap-
plication Settings or Driver Settings. The Preview image will display a sample im-
age using the current settings. You can Save Profile and name the Profile to recall
the settings at any time. Click Apply to save changes.

Figure C - 11
Intel® HD Graphics 

Control Panel Video 

(Basic - Driver 

Settings)
C - 12 Intel® HD Graphics Control Panel
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Click the Video menu at the top of the screen to display the sub-menus.The Image
Enhancement menu allows you to adjust the Sharpness, Skin Tone Enhance-
ment, Noise Reduction etc.Click Apply to save changes.

Figure C - 12
Intel® HD Graphics 

Control Panel Video 

Image 

Enhancement Basic
Intel® HD Graphics Control Panel C - 13
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The Image Scaling and Gamut Mapping menus allow you to adjust these items. 

Figure C - 13
Intel® HD Graphics 

Control Panel Video 

Image Scaling & 

Gamut Mapping
C - 14 Intel® HD Graphics Control Panel
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Display Devices & Options
Note that you can use external displays connected to the HDMI-Out port and/or ex-
ternal mini display port. See your display device manual to see which formats are
supported.

Display Mode
(Intel / Win8)

Description

Single Display
One of the connected displays is used as the display device 
(PC screen only or Second screen only).

Clone/Duplicate
Both connected displays output the same view and may be 
configured independently

Extended / Extend 
Both connected displays are treated as separate devices, and 
act as a virtual desktop

Table C - 1
Display Modes


Attaching Displays

When you first attach an external display you may find that the desktop does not occupy
the full screen area. Use either the display’s auto adjust/configure controls, or the Intel(R)
HD Graphics Control Panel to configure the full screen display.
Display Devices & Options C - 15
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Attaching Other Displays
To Clone Displays:
1. Attach your external display to the HDMI-Out port/mini display port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu).
3. Click Clone from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.
5. You can select the displays to be used from the Select Active Displays menu.


Multiple Display 

At least one other dis-
play must be attached in
order to view Multiple
Display selection op-
tions.

Figure C - 14
 Display > Multiple 

Displays (Clone)
C - 16 Attaching Other Displays
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To Enable Extended Mode:
1. Attach your external display to the HDMI-Out port/mini display port, and turn it on.
2. Go to the Intel(R) HD Graphics Control Panel control panel and click Display >

Multiple Displays (sub-menu).
3. Click Extended from the Select Multiple Display Mode menu.
4. Click Apply, and OK to confirm the settings change.


 Display Settings 

Extended Desktop 

You can have different
Colors, Screen Area
and Monitor Refresh
Rates for each display
device provided your
monitor can support
them.

You can drag the moni-
tor icons to match the
physical layout of your
displays. Icons and pro-
grams may also be
dragged between the
displays.

Figure C - 15 

Display > Multiple 

Displays (Extended)

Click the appropri-
ate monitor icon
and drag it to match
the physical ar-
rangement you
wish to use (e.g. the
secondary display
may be extended
left/right/above/be-
low the primary dis-
play).

Click Display Set-
tings to make any
adjustments re-
quired.
Attaching Other Displays C - 17
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Attaching Other Displays - Devices (Charms Bar)
You can configure attached displays from Devices (in the Charms Bar).

1. Attach your external display to the HDMI-Out port/mini display port, and turn it on.
2. Go the Charms Bar, select Devices.
3. Click Project (you may need to click Second Screen).
4. Click on any one of the options from the menu to select PC screen only,

Duplicate, Extend or Second screen only.


Windows Logo Key 

 + P Key 
Combination

You can use the  + P
key combination to
quickly bring up the Sec-
ond Screen menu.

You can also use the
Display Switch  but-
ton in the Control Cen-
ter to access the menu
and select the appropri-
ate attached display
mode.

You can also use the Fn
+F7 key combination to
quickly access the Sec-
ond Screen menu in
Windows 8.

Figure C - 16
Second Screen 

(Devices)
C - 18 Attaching Other Displays - Devices (Charms Bar)
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Configuring an External Display In Windows
1. Attach your external display to the HDMI-Out port/mini display port, and turn it on.
2. Go to the Screen resolution control panel (see page 1 - 29) in the Desktop app.
3. Click the Detect button.
4. The computer will then detect any attached displays.

Figure C - 17
Screen Resolution 

Multiple Displays
Attaching Other Displays - Devices (Charms Bar) C - 19
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5. You can configure the displays from the Multiple Displays menu.

• Duplicate these displays - Shows an exact copy of the main display desktop on 
the other display(s)

• Extend these displays - Treats both connected displays as separate devices
• Show desktop only on 1/2 - Only one of your displays is used.

Figure C - 18 

Screen Resolution 

Multiple Display 

Options
C - 20 Attaching Other Displays - Devices (Charms Bar)



Video Driver Controls

C

HDMI Audio Configuration
HDMI (High-Definition Multimedia Interface) carries both audio and video signals.
In some cases it will be necessary to go to the Sound control panel and manually
configure the HDMI audio output as per the instructions below.

1. Go to the Control Panel.
2. Click Sound  (Hardware and Sound) and click Playback (tab)
3. Depending on your display, the playback device may be selected, however in some 

cases you may need to select the audio device and click Set Default (button).
4. Double-click the device to access the control panel tabs illustrated overleaf.


Volume Adjustment

The sound volume level
can be set using the vol-
ume control in the Set-
tings menu in the
Charms Bar.

Figure C - 19
Sound - HDMI 

Device (set Default)
HDMI Audio Configuration C - 21
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5. Adjust the HDMI settings from the control panel tabs.
6. Click OK to close the Sound  control panel.

Figure C - 20
HDMI Device 

Properties
C - 22 HDMI Audio Configuration
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HDMI Notes
• Connect a device with HDMI support to the HDMI-Out port BEFORE attempt-

ing to play audio/video sources through the device.
• To play audio sources through your external display’s (TV or LCD) speakers 

you will need to go to the audio configuration control panel on the display and 
configure the audio input accordingly (see your display device manual).

HDMI Video Configuration
1. Connect an HDMI cable from the HDMI-Out port to your external display.
2. Configure your external display as per the instructions in “Attaching Other

Displays” on page C - 16.
3. Set up your external display (TV or LCD) for HDMI input (see your display device

manual).
4. You can now play video/audio sources through your external display.


Other Applications

If you are using a third
party application to play
DVDs etc. from any at-
tached DVD device,
you will need to consult
the application’s docu-
mentation to see the
appropriate audio con-
figuration (the applica-
tion must support digital
to analog translation).
HDMI Audio Configuration C - 23
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Appendix D: Specifications


Latest Specification Information

The specifications listed in this Appendix are correct at the time of going to press. Certain items (particularly processor types/
speeds and CD/DVD device types) may be changed, updated or delayed due to the manufacturer's release schedule. Check
with your distributor/supplier for details.
Specifications D - 1
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Processors

Intel® Core™ i7-4750HQ processor 
(22nm, 2.00GHz, DDR3L-1600MHz, 6MB 
L3 cache, TDP: 47W)

Core Logic

Mobile Intel® HM87 Express Chipset

Display

14.0” / 35.56cm HD (1366 * 768) / FHD 
(1920 * 1080) 16:9, 3.2mm thick Backlit 
Panel

Memory

Dual Channel DDR3L

Two 204 Pin SO-DIMM Sockets 
Supporting DDR3L 1600 MHz Memory 
Modules (real operational frequency 
depends on the FSB of the processor)

Memory Expandable up to 16GB
Compatible with 2GB, 4GB or 8GB Modules

Video Adapter

Intel® HD Graphics 5200
(GPU is Dependent on Processor):

Dynamic Frequency
Intel Dynamic Video Memory Technology 
up to 1.7MB
Microsoft DirectX®11 Compatible

Storage

One Changeable 2.5", 9.5 mm / 7 mm (h) 
HDD with SATA (Serial) Interface

mSATA SSD (Solid State Drive) with 
SATA (Serial) Interface (Factory Option)

Audio

High Definition Audio Interface
Built-In Microphone
2 * Built-In Speakers

Keyboard & Pointing Device

Built-in Touchpad with Multi-Gesture 
Functionality

Isolated A4 Size Keyboard

Interface

Three USB 3.0 Ports (Including one AC/
DC Powered USB 3.0 Port)
One Mini Display Port
One HDMI-Out (High-Definition 
Multimedia Interface) Port (with HDCP)
One Headphone-Out Jack
One Microphone-In Jack
One RJ-45 LAN Jack
One DC-In Jack

Card Reader

Embedded Multi-In-1 Card Reader 
- MMC/ RS MMC
- SD/ Mini SD / SDHC/ SDXC
Note: Some of these cards require PC 
adapters that are usually supplied with 
the cards.

Mini Card Slots

Slot 1 for Half Size Mini-Card WLAN 
Combo Module with PCIe & USB 
Interfaces

Slot 2 for Full Size Mini-Card SSD (Solid 
State Drive) with SATA Interface
D - 2 Specifications
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Communication

Built-In 10/100/1000Mb Base-TX 
Ethernet LAN

1.0M HD Video Camera Module with 
USB interface

Intel® Centrino® Advanced-N 6235 (2*2
802.11 a/g/n) Half Mini-Card PCIe WLAN &
Bluetooth 4.0 Combo Module (Factory Op-
tion)

Intel® Centrino® Advanced-N 6205 (2*2
802.11 a/g/n) Half Mini-Card PCIe WLAN
Module (Factory Option)

(802.11b/g/n) Half Mini-Card PCIe WLAN 
Module with PCIe Interface (Factory 
Option)

(802.11b/g/n) Half Mini-Card PCIe WLAN 
+ Bluetooth V4.0+LE Combo Module 
(Factory Option)

Power

Full Range AC/DC Adapter 
AC input 100 - 240V, 50 - 60Hz, 
DC Output 19V, 4.74A (90 Watts)

Battery

Polymer Smart Lithium Ion Battery Pack 
53.28WH

Power Management

Supports Wake on LAN
Supports Wake on USB
Supports Wake on RTC Alarm (AC Mode 
Only)

LED Indicators

Power/Suspend, Battery, HDD/ODD, 
Airplane Mode, Camera

BIOS

One 48Mb SPI Flash ROM
AMI BIOS

Security

Security (Kensington® Type) Lock Slot
BIOS Password

Features

Painted Style (For some Model designs 
in this series)
Intel® Rapid Start Technology
Intel® Smart Response Technology
Intel® Anti-Theft Technology
Intel® Identity Protection Technology

Operating System

Windows® 8 (64-bit)/Windows® 8.1 (64-
bit)
Windows® 10 (64-bit)/

Environmental Spec

Temperature 
Operating: 5°C - 35°C
Non-Operating: -20°C - 60°C
Relative Humidity
Operating: 20% - 80%
Non-Operating: 10% - 90%

Dimensions & Weight

340mm(w) * 253mm(d) * 20.8mm(h)
1.9kg with Battery
Specifications D - 3
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Appendix E: Windows 10

Overview
This Appendix contains information (including control panel information, driver installation etc.) for users of
the Windows 10 OS.

You can refer to the main manual for details of audio & video information, BIOS, modules etc. However drivers
information specific to Windows 10 will be included in this Appendix, as well as details on how to navigate the
Windows 10 user interface to access the applications, control panels, taskbar etc. Note that Windows 10 will be
subject to constant updates and revisions, and some of the screens pictured throughout this chapter may change
over the course of time and appear differently from those illustrated.


Windows 10 OS

In order to run Windows 10 64 bit) your computer requires a minimum 2GB of system memory (RAM).
Overview E - 1
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Windows 10 Start Menu
Most of the apps, control panels, utilities and programs within Windows 10 can be accessed from the Start
Menu by clicking the icon  in the taskbar in the lower left corner of the screen (or by pressing the Windows
Logo Key  on the keyboard).

Figure E - 1 - Windows Start Menu

Desktop
E - 2 Windows 10 Start Menu
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Right-Clicking the Windows Logo In Start Menu
Right-click the Start Menu  icon (or use the Windows Logo Key  + X key combination) to bring up an
advanced Context Menu of useful features such as Control Panel, Programs and Features, Power Options, Task
Manager, Search, File Explorer, Command Prompt, Device Manager and Network Connections etc.

Figure E - 2 - Right-Click Windows Logo in Start Menu

Right-Click Icon
Windows 10 Start Menu E - 3
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Start Menu Apps & Tiles
The Windows 10 Start Menu will contain a number of apps, and many more will be installed as you add more
applications etc. Not all of these apps can fit on the screen so may need click and drag the handles at the edge of
the screen to expand the menu in order to view all the apps (you can use the scroll bar to move up and down the
screen).

Figure E - 3 - Expanding the Start Menu
E - 4 Windows 10 Start Menu
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Pining/Unpinning Apps & Programs to/from the Start Menu
To make things easy to find you can add and remove tiles for apps and programs to the Start Menu. Right-Click
on a program’s icon and select Pin to Start from the drop-down menu. To remove an app or program from the
Start Menu right-click the icon and select Unpin from Start. You can use the same method to pin apps/pro-
grams to/from the taskbar (select pin to taskbar/unpin this program from the taskbar). 

Figure E - 4 - Pin to Start/Unpin from Start
Windows 10 Start Menu E - 5
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Windows 10 Control Panel
In many instances throughout this manual you will see an instruction to open the Control Panel. The Control
Panel can be accessed in a number of ways in Windows 10.

Figure E - 5 - Windows 10 Control Panel Access

• Right-click the Start Menu icon 
 in the taskbar in the lower left 

corner of the screen and select 
Control Panel from the menu. 

• Press the Windows logo key  
on your keyboard and X to bring 
up the context menu, and then 
press P to bring up the Control 
Panel.

• Type Control Panel into the 
Search box in the taskbar and 
click on the icon when it pops up.
E - 6 Windows 10 Control Panel
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Settings
The Settings item in the Start Menu (and also as an App) gives you quick access to a number of system settings
control panels allowing you to adjust settings for System, Devices, Network & internet, Personalization, Ac-
counts, Time & language, Ease of Access, Privacy and Update & security.

Figure E - 6 - Settings
Windows 10 Control Panel E - 7
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Windows 10 Taskbar
In many instances throughout this manual you will see an instruction to access the notification area of the task-
bar. The notification area of the taskbar in the bottom right of the screen. Some of the Control Panels and appli-
cations referred to throughout the course of this manual can be accessed from here.

Figure E - 7 - Taskbar

You can pin/unpin apps to/from the taskbar in much the same way as you can to the Start screen (see “Pining/
Unpinning Apps & Programs to/from the Start Menu” on page E - 5).

Taskbar

Taskbar - Pinned Programs and Apps Notification Area
E - 8 Windows 10 Control Panel
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Video Features
You can switch display devices, and configure display options, from the Display control panel (in Appearance
and Personalization). Click Adjust resolution to make changes to the appearance of the display and to detect
and configure any attached displays. In Windows 10 it is possible to quickly configure external displays from
the Project menu (press the Windows logo key  on your keyboard and the P key).

To Configure Displays using Project

Figure E - 8 - Project

1. Attach your display to the appropriate 
port, and turn it on.

2. Press the  + P key combination.
3. Click on any one of the options from

the menu to select PC screen only,
Duplicate, Extend or Second
screen only.

4. You can also click Connect to a
wireless display at the bottom of the
Project screen and follow the steps
to connect to any wireless enabled
display.
Video Features E - 9
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To access Display (Control Panel) and Screen Resolution in Windows:
1. Go to the Control Panel.
2. Click Display (icon) - In the Appearance and Personalization category.
3. Make and changes required from the Display, Resolution, Orientation or Multiple display menus.
4. Click Apply to save the settings.

Figure E - 9 - Screen Resolution

2

1


Screen Resolution

1. Use the dropbox to select 
the screen Resolution  
(Figure E - 9).

2. Click Advanced settings 
 (Figure E - 9) to bring up 

the Advanced properties 
tabs.

3. Click Apply to save any 
changes made.

1

2
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Display Settings:
1. You can quickly adjust the display by right-clicking the desktop and selecting Display Settings .
2. Adjust the settings using the sliders in the menu or click Advanced display settings  to change resolution.
3. Click Apply to save any changes made to resolution.

Figure E - 10 - Display Settings

1
2

2

1
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Power Options
Power Options (Hardware and Sound) can be accessed from the Control Panel. The Power button item in
Start Menu (or the context menu) may be used to Shut down or Restart (you can also add Hibernate/Sleep to
the menu - see page E - 13). To fully control all the power options (including Hibernate mode) go to the Power
Options control panel and configure the power button, sleep button and lid to perform the function selected.

Figure E - 11 - Shut Down/Restart 

Using the Power Button
1. Go to the Start Menu.
2. Click the Power button .
3. Select the power state required

from the menu.
E - 12 Power Options
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You can also use the context menu (right-click the Start Menu  icon or press the Windows logo  + X key
combination) to Sign out, Sleep, Hibernate, Shut down, and Restart.

Figure E - 12 - Context Menu Shut Down or sign out

Ctrl + Alt + Delete Key Combination
You can use the CTRL + ALT + DEL key combination to bring up a full-screen displaying Lock, Sign out,
Change a password, Task Manager and Switch User. If you click the Power icon in the lower right corner of
the screen a power management option menu appears to display Sleep, Hibernate, Shut down, and Restart.


Adding Hibernate/Sleep to the Power Men

1. Go to the Power Options (Hardware and Sound) 
control panel.

2. Click Choose what the power buttons do.
3. Click “Change settings that are currently 

unavailable” .
4. Click to put a check in the Hibernate/Sleep box 

under Shutdown settings.
5. Click Save Changes and close the control panel.
Power Options E - 13
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Minimum Screen Resolution Settings
1. Windows 10 has minimum screen resolution requirements.
2. Right-click a blank area of the Desktop and select Screen Resolution (or go to the Display control panel).
3. Adjust the Resolution to make sure that it is at least 1024 * 768, although preferably 1366 * 768 or above.

Figure E - 13 - Screen Resolution
E - 14 Power Options
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Windows 10 Drivers & Utilities
Make sure you install all the drivers and utilities for your Windows 10 system as outlined in the following pages.

Driver Installation (Windows 10)
1. Insert the Device Drivers & Utilities + User’s Manual disc into the computer’s DVD drive, or an attached DVD 

drive if applicable.
2. Click the message “Tap to choose what happens with this disc.”
3. Click Run autorun.exe.
4. Click Install Drivers (button), or Option Drivers (button) to access the Optional driver menu.
5. Check the driver installation order from Table E - 1, on page E - 16 (the drivers must be installed in this 

order) which is the same as that listed in the Drivers Installer menu below.
6. Click to select the driver you wish to install, (you should note down the drivers as you install them).
7. Follow the instructions for each individual driver installation procedure as listed on the appropriate pages.


Driver Installation

If you miss the message above you can eject the De-
vice Drivers & Utilities + User’s Manual disc and then
reinsert it.

Alternatively double-click the disc icon in Comput-
er (use the Windows logo key  + E key combina-
tion to go to Computer in Windows Explorer).
Windows 10 Drivers & Utilities E - 15
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Table E - 1 - Driver Installation

Windows 10 (64-bit) Drivers

 Chipset Page E - 17  Wireless LAN Module Page E - 20

 Video (VGA) Page E - 17  Bluetooth & WLAN Combo Module Page E - 22

 LAN Page E - 17  Intel® Rapid Storage Technology Page E - 25

 Card Reader Page E - 17  PC Camera (No driver required) Page E - 26

 Touchpad Page E - 17  Trusted Platform Module (No driver required) Page E - 27

 Airplane Page E - 18

 Control Center Page E - 18

 MEI Driver Page E - 18

 Audio Page E - 18
E - 16 Windows 10 Drivers & Utilities
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Driver Installation Procedure
Insert the Device Drivers & Utilities + User’s Manual
disc and click Install Drivers (button).

Chipset
1. Click 1.Install Chipset Driver > Yes.
2. Click Next > Accept > Install.
3. Click Restart Now to restart the computer.

Video (VGA)
1. Click 2.Install VGA Driver > Yes.
2. Click Next > Yes > Next > Next.
3. Click Finish to restart the computer.

Note: After installing the video driver go to the Dis-
play control panel to adjust the video settings to the
highest resolution.

LAN
Note: If the computer enters a deep sleep mode during
installation, you will be prompted to plug in a network
cable, and click OK, to continue installation. If a net-
work cable is not available, restart the system and re-
install the LAN driver.

1. Click 3.Install LAN Driver > Yes.
2. Click Next > Install.
3. Click Finish.

Card Reader
1. Click 4.Install Cardreader Driver > Yes.
2. Click Finish.

Touchpad
1. Click 5.Install Touchpad Driver > Yes.
2. Click Next.
3. Click the button to accept the license, and then 

click Next.
4. Click Finish > Restart Now to restart the com-

puter.
Windows 10 Drivers & Utilities E - 17
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Airplane
Note: Do not use Update Driver in Device Manager to
install the Airplane Mode driver.

1. Click 6.Install Airplane Driver > Yes. 
2. Click Next > Install.
3. Click Finish to restart the computer.

Control Center
1. Click 7.Install Control Center AP > Yes.
2. Click Next > Install.
3. Click Finish to restart the computer.

MEI Driver
1. Click 8.Install MEI Driver > Yes.
2. Click Next.
3. Click the check box to accept the license and 

then click Next.
4. Click Next.
5. Click Finish.

Audio
1. Click 9.Install Audio Driver > Yes. 
2. Click Next.
3. Click the button to agree to the license and 

click Next.
4. Click Next > Next > Next.
5. Click Finish to restart the computer.

Note that after installing the audio driver the system
will not return to the Drivers Installer screen. To in-
stall any of the optional drivers listed overleaf, eject
the Device Drivers & Utilities + User’s Manual disc
and then reinsert it (or double-click the disc icon in My
Computer), and click Option Drivers (button) to ac-
cess the optional driver menu.
E - 18 Windows 10 Drivers & Utilities
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Optional Drivers
See the following pages for the driver installation procedures for any modules included in your purchase option.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.
Windows 10 Drivers & Utilities E - 19
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Wireless LAN Module
If you have included an Intel® or 3rd Party WLAN module in your purchase option make sure that the module
is on (i.e. the system is not in Airplane Mode) before installing the driver. Make sure you install the drivers in
the order indicated in Table E - 1, on page E - 16.

Note that you need to install both the WLAN & Bluetooth drivers for the WLAN & Bluetooth Combo modules.


Wireless Device 

Operation Aboard Aircraft

The use of any portable electronic
transmission devices aboard aircraft is
usually prohibited. 

Make sure the module is either OFF or
in Airplane mode if you are using the
computer aboard aircraft.
E - 20 Wireless LAN Module
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3rd Party WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. The operating system is the default setting for Wireless LAN control in Windows 10.
7. Click the Wireless icon  in the notification area of the taskbar and double-click an access point to 

connect to it (or click it and click Connect).

Intel® WLAN Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 1.Install WLAN Driver > Yes.
4. Click in the check box to agree to the End User License Agreement and click Install.
5. Click Finish (click Yes if required to restart).
6. The operating system is the default setting for Wireless LAN control in Windows 10.
7. Click the Wireless icon  in the notification area of the taskbar and double-click an access point to 

connect to it (or click it and click Connect).
Wireless LAN Module E - 21
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Bluetooth & WLAN Combo Module
If your purchase option includes the Combination Wireless LAN & Bluetooth module (either Intel® or 3rd
Party) then install the driver as instructed overleaf (two drivers are provided for the 3rd party WLAN module and
one for the Intel WLAN module). Make sure you install the drivers in the order indicated in Table E - 1, on
page E - 16.

Make sure that the module is on (i.e. the system is not in Airplane Mode) before installing the driver.


Bluetooth Data Transfer

Note that the transfer of data between the computer and a Bluetooth enabled device is supported
in one direction only (simultaneous data transfer is not supported). Therefore if you are copying
a file from your computer to a Bluetooth enabled device, you will not be able to copy a file from
the Bluetooth enabled device to your computer until the file transfer process from the computer
has been completed.


Wireless Device Operation Aboard Aircraft

The use of any portable electronic transmission devices aboard aircraft is usually prohibit-
ed. Make sure the module is either OFF or in Airplane mode if you are using the computer
aboard aircraft.
E - 22 Bluetooth & WLAN Combo Module
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3rd Party Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next.
5. Click Finish to restart the computer.
6. See “Bluetooth Configuration” on page E - 24 for instructions on configuring Bluetooth connections.

Intel Bluetooth Combo Driver Installation
1. Make sure the system is not in Airplane Mode, and then insert the Device Drivers & Utilities + 

User’s Manual disc into the DVD drive. 
2. Click Option Drivers (button).
3. Click 2.Install Combo BT Driver > Yes.
4. Click Next > Next.
5. Click in the check box to accept the license and click Next.
6. Select the setup type (Typical is recommended) and click Install.
7. Click Finish.
8. See “Bluetooth Configuration” on page E - 24 for instructions on configuring Bluetooth connections.
Bluetooth & WLAN Combo Module E - 23
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Bluetooth Configuration
1. Click the Settings item in the Start Menu and then click Devices.
2. Click Bluetooth and make sure Bluetooth is On and a list of discovered devices will appear.
3. Double-click the device you want to pair with the computer and click Pair.
4. On first connection the computer will provide you with a pairing code to be entered onto the device.
5. Enter the code into your Bluetooth enabled device and click Yes on the computer to complete the pairing.
6. Select a device and click Remove Device to disconnect from any device.
7. Click More Bluetooth Options, and make sure that Allow Bluetooth devices to find this computer check 

box (Discovery) has a check inside it.
8. Make sure that the Alert me when a new Bluetooth device wants to connect check box (Connections) has 

a check inside it, if you want to be notified when a Bluetooth device wants to connect.
E - 24 Bluetooth & WLAN Combo Module
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Intel® Rapid Storage Technology
Install the Intel® Rapid Storage Technology to support your AHCI mode SATA drive (see “SATA Mode (Ad-
vanced Menu)” on page 5 - 8).

IRST Driver Installation
1. Insert the Device Drivers & Utilities + User’s Manual disc into an attached DVD drive.
2. Click Option Drivers (button).
3. Click 3.Install IRST Driver > Yes.
4. Click Next.
5. Click the check box to accept the license and click Next.
6. Click Next > Next > Next.
7. Click Finish to restart the computer.
8. Run the Intel® Rapid Storage Technology app from the All Apps screen (in the Start Menu).


IRST and M.2 PCI-e SSDs

Note that Intel® Rapid Storage Technology does not support M.2 SSDs with a PCI-e In-
terface (M.2 SSDs with a SATA Interface are supported).
Intel® Rapid Storage Technology E - 25
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PC Camera
Use the Fn + F10 key combination or Control Center button to toggle power to the PC Camera module. When
the PC Camera is in use the LED indicator to the left of the camera will be illuminated in red.

Note that you need to use the Camera app  in Windows to take pictures and capture video.

1. Make sure the PC Camera is turned on by using the Fn + F10 key combination (or Control Center button).
2. Run the Camera app from the Start menu by clicking on the Camera app icon  (you can type “camera” into 

the search box to find the Camera app if it is not pinned to the Start menu).
3. Click to select either photo  or video  modes.
4. Click the photo icon to take a picture, and the camera icon will briefly turn yellow as the picture is taken.
5. Click on the video icon  to start video capture (if video capture begins a timer will appear at the bottom of the 

screen and the icon will turn yellow).
6. To stop video capture click the video icon again.
7. Captured photos and videos will be saved to a Camera Roll folder within the Pictures/Videos folder in This 

PC, and to the Photos app stored in the Start menu (type Photos into the search box if you cannot find the 
app). 
E - 26 PC Camera
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Trusted Platform Module
The TPM security chip allows you to create and manage digital certificates for user and platform authentica-
tion. This type of security is usually administered within large enterprises and organizations, and therefore re-
quires implementation by a system administrator before users can access security features. 

Make sure you have administrator’s rights to your computer, and have a Windows password enabled for full se-
curity protection. In addition Make sure you prepare a removable media (e.g. a USB flash drive) to store
passwords etc. before beginning the TPM initialization process.

Before setting up the TPM functions you must enable and initialize the security platform (see “Enabling & Ac-
tivating TPM” on page 6 - 22).

TPM Management in Windows
1. Go to the Control Panel.
2. Click BitLocker Drive Encryption (System and Security).
3. Click TPM Administration.
4. The TPM Management window allows you to configure the TPM within Windows. As TPM is usually 

administered within large enterprises and organizations, your system administrator will need to assist you in 
managing the information here.

5. Click Prepare the TPM and follow the instructions in the Wizard to prepare the TPM (this will probably require a 
restart of the computer and confirmation of the setting changes after restart by pressing the appropriate F key).

6. After the restart the TPM will be prepared and you can then use the Actions menu to Turn TPM off, Change 
Owner Password, Clear TPM or Reset TPM Lockout.

7. A wizard will help take you through any setup steps.
Trusted Platform Module E - 27
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